Table of contents

Table of contents .................................................................................................................. 3
Introduction .............................................................................................................................. 9
  Features, licenses and releases .............................................................................................. 9
  Copyright notice .................................................................................................................... 10
What's new? ............................................................................................................................ 11
Getting started ....................................................................................................................... 12
  Logging in ........................................................................................................................... 12
  Accessing features .............................................................................................................. 12
  Navigation .......................................................................................................................... 12
  Next steps .......................................................................................................................... 13
Roles and tasks ....................................................................................................................... 13
  Visitor ................................................................................................................................ 13
  Community member .......................................................................................................... 13
  Content editor .................................................................................................................... 14
  Marketer .............................................................................................................................. 14
  Merchandiser ..................................................................................................................... 14
  Website owner .................................................................................................................... 14
  Administrator ..................................................................................................................... 14
  Developer ............................................................................................................................ 14
Administration interface ........................................................................................................ 16
  Administration view ........................................................................................................... 16
  Visitor groups .................................................................................................................... 16
  Add-ons ............................................................................................................................... 16
More on administration ......................................................................................................... 17
  Administration in Episerver Commerce .............................................................................. 17
  Administration in Episerver Find ....................................................................................... 18
Table of Contents

- Editing tab ................................................................. 51
- Managing websites ..................................................... 53
  - Requirements ......................................................... 53
  - Adding and updating a website from admin view ............ 54
- Managing website languages ......................................... 58
  - Language overview ............................................... 58
  - Adding and enabling languages ................................. 58
  - Deleting an existing language ................................. 62
- Managing content approval sequences (Beta) .................... 63
  - Content approvals on assets ................................... 64
  - Content approvals on multi-language sites .................. 66
  - Setting up an approval sequence ............................. 66
    - Setting up an approval sequence (single language website) 66
    - Setting up an approval sequence for children items .......... 67
    - Setting up an approval sequence on a multiple languages website 68
  - Editing an approval sequence .................................. 69
  - Approving and canceling approval sequences ............... 69
  - Deleting an approval sequence .................................. 70
  - Using notifications ............................................... 70
- Creating categories ................................................. 71
  - Adding a category ................................................ 71
  - Deleting or changing a category ................................ 72
- Editing frames and tabs ............................................ 73
  - Frames .............................................................. 73
  - Tabs ................................................................. 73
    - Adding and editing a tab ..................................... 74
- Permissions for functions ........................................... 75
  - Setting of access rights from Permissions for Functions .... 75

© Episerver 2017
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding/Changing permissions to a function for a group or user</td>
<td>75</td>
</tr>
<tr>
<td>Deleting permissions to a function for a group or user</td>
<td>75</td>
</tr>
<tr>
<td><strong>Tool settings</strong></td>
<td>76</td>
</tr>
<tr>
<td>Plug-in manager</td>
<td>76</td>
</tr>
<tr>
<td>Change log</td>
<td>76</td>
</tr>
<tr>
<td>Rebuild name for web addresses</td>
<td>78</td>
</tr>
<tr>
<td>Mirroring</td>
<td>79</td>
</tr>
<tr>
<td>Configuring A/B Testing</td>
<td>83</td>
</tr>
<tr>
<td>Search configuration</td>
<td>84</td>
</tr>
<tr>
<td>Enabling search providers</td>
<td>84</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>86</td>
</tr>
<tr>
<td>Property types</td>
<td>86</td>
</tr>
<tr>
<td>Editing and adding properties on content types</td>
<td>86</td>
</tr>
<tr>
<td>Defining language-specific properties</td>
<td>89</td>
</tr>
<tr>
<td>Organizing properties in content</td>
<td>90</td>
</tr>
<tr>
<td>Configuring customized property settings</td>
<td>91</td>
</tr>
<tr>
<td>Creating custom property types</td>
<td>92</td>
</tr>
<tr>
<td>Configuring the rich-text editor</td>
<td>93</td>
</tr>
<tr>
<td>Changing the layout of the editor</td>
<td>93</td>
</tr>
<tr>
<td>Enabling plug-ins</td>
<td>95</td>
</tr>
<tr>
<td>Configuring global and custom settings</td>
<td>95</td>
</tr>
<tr>
<td><strong>Content types</strong></td>
<td>97</td>
</tr>
<tr>
<td>Content types and properties</td>
<td>97</td>
</tr>
<tr>
<td>Page types</td>
<td>98</td>
</tr>
<tr>
<td>Editing a page type</td>
<td>98</td>
</tr>
<tr>
<td>Creating a page type from admin view</td>
<td>100</td>
</tr>
<tr>
<td>Copying an existing page type</td>
<td>103</td>
</tr>
<tr>
<td>Block types</td>
<td>104</td>
</tr>
</tbody>
</table>

© Episerver 2017
Table of Contents | 7

Other content types .................................................................................................................. 104
Converting pages ..................................................................................................................... 104

Visitor groups ....................................................................................................................... 107
Built-in visitor group criteria .................................................................................................... 107
Managing visitor groups ......................................................................................................... 108
Examples of creating visitor groups ......................................................................................... 111
Additional visitor group criteria ............................................................................................... 113
Episerver Commerce criteria .................................................................................................. 114
Episerver Visitor Group Criteria Pack ..................................................................................... 114

Index ....................................................................................................................................... 115

© Episerver 2017
Introduction

The features and functionality of the entire Episerver platform are described in an online help that opens in a web browser. The online help covers CMS for content management, Commerce for e-commerce functionality, Find for extended search, and Episerver add-ons. It is either accessed from within the Episerver platform or from Episerver World. The online help is also divided into a number of PDFs for users who prefer those or want to print the documentation.

This PDF describes the features and functionality of Episerver CMS. PDFs for Episerver Commerce and Find can be found on Episerver World. The user documentation is intended for editors, administrators, marketers and merchandisers, working with tasks as described in Roles and tasks.

Developer guides and technical documentation are also found on Episerver World.

Features, licenses and releases

The user documentation is continuously updated and covers the latest releases for the Episerver platform.

**CMS**

Episerver CMS is the core part of the Episerver platform providing advanced content creation and publishing features for all types of website content. CMS features are available in all Episerver installations.

**Commerce**

Episerver Commerce adds complete e-commerce capabilities to the core functionality in CMS. Commerce requires additional license activation.
Add-ons extend the Episerver capabilities with features like advanced search, multi-variate testing, and social media integration. Some add-ons are free, others require license activation. Add-ons by Episerver are described in the online help.

Due to frequent feature releases, this user guide may describe functionality that is not yet available on your website. Refer to What’s new to find out in which area and release a specific feature became available.

Copyright notice

© Episerver 1996 – 2017. All rights reserved.

All information and content within this document is the sole copyright of Episerver. Changes to the contents, or partial copying of the contents, may not be done without permission. The document may be freely distributed in its entirety, either digitally or in printed format, to all users of Episerver Software. We assume no liability or responsibility for any errors or omissions in the content of this document. We reserve the right to alter functionality and technical system requirements. Episerver is a registered trademark of Episerver AB. Ektron is a registered trademark of Episerver Inc.
What's new?

The Episerver user guide describes features in the Episerver platform, including CMS for content management and Commerce for e-commerce management, and add-ons from Episerver. New features are continuously made available through Episerver updates.

This user guide (17-2) describes **features added up until and including update 154** for Episerver; see Episerver World for previous user guide versions.

<table>
<thead>
<tr>
<th>Area</th>
<th>Features and updates</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMS</td>
<td>The content approvals feature now includes approvals on assets such as blocks and media. (update 154)</td>
</tr>
<tr>
<td></td>
<td>A new field, Remaining URL, has been added to the Create/Edit link dialog box. In this field, you can add query string parameters to internal links. Read more about this in Adding links. (update 151)</td>
</tr>
<tr>
<td></td>
<td>A/B Testing: A new KPI has been added which allows you to select the total average order as a conversion goal. See A/B testing for more information. (update 151)</td>
</tr>
<tr>
<td></td>
<td>A/B Testing: A new KPI has been added which allows you to select a target page and a timeout period. An A/B test conversion is counted if a visitor goes from the target page to another page on your website within the defined time period. See A/B testing for more information. (update 152)</td>
</tr>
</tbody>
</table>
Getting started

This section describes how to log in to an Episerver website, access features and navigate the different views. Note that the login procedure may be different from what is described here, depending on how your website and infrastructure are set up. The examples described here are based on a “standard” installation of Episerver with sample templates.

Logging in

As an editor or administrator, you usually log in to your website using a specified URL, a login button or link. Enter your user name and password in the Episerver login dialog, and click Log In.

Accessing features

What you are allowed to do after logging in depends on your implementation and your access rights, since these control the options you see. When logged in, the Episerver quick access menu is displayed in the upper right corner.

Selecting CMS Edit takes you to the edit view as well as other parts of the system. You can go directly to your personal dashboard by selecting the Dashboard option.

Navigation

Pull down the global menu, available at the very top, to navigate around. The menu displays the different products and systems integrated with your website. Select, for instance, CMS to display available options in the submenu.

Your menu options vary depending on your access rights. These user guide examples assume that the user has full permissions to all functions in Episerver.
Next steps

Refer to the sections below for more information.

- User interface and Roles and tasks in the CMS Editor User Guide for information about the Episerver user interface and roles.
- Managing content in the CMS Editor User Guide for information on how to create and publish content.
- Administration interface in the CMS Administrator User Guide for information on how to administer and configure settings in Episerver.
- Commerce User Guide for information on how to work with e-commerce tasks, if you have Episerver Commerce installed.
- Find User Guide for information on how to work with search optimization, if you have Episerver Find installed.

Roles and tasks

Episerver is designed for interaction with website visitors, as well as collaboration between users. A user in Episerver is someone working with different parts of the platform. A user can belong to one or more user groups and roles, depending on their tasks as well as the size and setup of the organization. Typical roles and related tasks are described below. Refer to Setting access rights in the CMS Administrator User Guide for information on how to configure user groups and roles in Episerver.

Visitor

A visitor is someone who visits the website to find information or to use available services, on an e-commerce website possibly with purchasing intentions. Purchasing on an e-commerce website can be done either "anonymously" (payment and shipping details provided), or by registering an account. Visitors may also contribute to website content as community members, which usually requires registration of an account profile.

Community member

Content may be added by visitors or community members, if social features and community functionality are available for the website. This content includes forum and blog postings, reviews, ratings and comments, in which case there might be a need for monitoring this type of content on the website. Monitoring can be done for instance by an editor, or a specific moderator role for large websites and online communities.
**Content editor**

A content editor is someone with access to the editorial interface who creates and publishes content on the website. Content editors with good knowledge of the website content work with search optimization for selected content in search results. Editors may also want to follow-up on content with unusually high or low conversion rate in order to update or delete this content.

**Marketer**

A marketer creates content and campaigns with targeted banner advertisements to ensure customers have consistent on site experience of the various marketing channels. Furthermore, the marketer monitors campaign KPIs to optimize page conversion. A marketer with good knowledge of the website content may also want to monitor search statistics in order to optimize search for campaigns and promote content.

**Merchandiser**

A merchandiser typically works with stock on an e-commerce website to ensure that the strongest products are put in focus. This role also creates landing pages, sets product pricing, coordinates cross-product selling, oversees delivery and distribution of stock, and deals with suppliers. This user wants to be able to identify search queries with unusually high or low conversion rates, in order to adjust either the search or the product line.

**Website owner**

A website owner is someone with overall responsibility for the content and performance of one or more websites. This user monitors website activities such as page conversions, customer reviews or sales progress. Rarely creates content but can be involved in the approval of content created by others. A website owner may have administrative access rights and may be able to install selected add-ons on the website.

**Administrator**

An administrator works with configuration of various system settings from the administration user interface, including search, languages, user access rights and visitor groups for personalized content. Administrators may also install add-ons on the website. Administrators usually have extended access rights compared to other user groups, and can access all parts of the Episerver platform.

**Developer**

A developer is someone with programming skills working with the setup and implementation of the website, as well as maintenance and development of new functionality. Creates the content templates for pages, blocks and catalog content used by editors in CMS and Commerce, configures e-commerce
settings, and manages the index and customized search features in Find. Developers may also install add-ons on the website.
Administration interface

Depending on which parts of the Episerver platform are implemented, you have various administration options in the user interface. The options in this topic apply to a standard installation of Episerver and related products; a customized site might have additional administration options.

Administration view

The admin view in CMS contains core administration features for the Episerver platform where you manage access rights, website languages, and scheduled jobs. You also manage the export and import of data between websites, and configure new websites in a multi-site solution.

Visitor groups

Visitor groups are used by the personalization feature, and are managed from the Visitor Groups option in the global menu. You need administration access rights to manage visitor groups.

Add-ons

It is recommended to install add-ons via Visual Studio and NuGet packages. For more information, see Episerver World.
The add-on system keeps track of system dependencies and lists installed and available add-ons and updates. You also can manually upload unlisted add-ons to the website.

The following views are available:

- **Installed** lists installed add-ons. When an update is available a notification is displayed here. Click the header columns to sort the list of available add-ons.
- **Episerver Add-ons, Episerver Beta** and **Third-Party Add-ons** list available add-ons from Episerver or third-party providers.
- **Updates** lists available upgrades for your website, based on products and system versions installed in your environment.

In the image, the installed add-ons are displayed, including:

- **EPIServer GoogleAnalytics** (1.3.0.75): Enables editors to add tracking script and view analytics data in EPIServer. Refer to the user guide at [http://webhelp.episerver.com](http://webhelp.episerver.com)
- **EPIServer Publish from Office 1.0.3.75**: Allows editors to publish MS Word content as pages in EPIServer CMS. Refer to the user guide at [http://webhelp.episerver.com](http://webhelp.episerver.com)
- **EPIServer Self-Optimizing Block 2.0.1.75**: Used for multivariate testing of blocks in EPIServer CMS.
- **EPIServer Social Reach 1.5.0.75**: Enables editors to send updates on social channels using a unified workspace. Refer to the user guide at [http://webhelp.episerver.com](http://webhelp.episerver.com)

More on administration

**Commerce Administration in Episerver Commerce**

If you have Episerver Commerce installed on your website, Commerce has an administrative interface for managing e-commerce-specific settings. See the Administration section in the user guide for
Episerver Commerce.

**Find Administration in Episerver Find**

If you have added Episerver Find to your website, there are some specific administration and configuration options available to optimize the search functionality. See the Administration and configuration section in the user guide for Episerver Find.
CMS Access rights

By using access rights in Episerver, you can control the content that a website visitor sees, as well as what editors can do and where they can do it in the content structure. For example, you may give members of the Marketing department access to edit the website marketing material that other company users should not edit. You can set access rights for different types of content, such as pages, blocks, images and documents in the navigation and assets panes.

You can also use access rights together with visitor groups and give a visitor group from a local 10-mile radius access to an advertisement page.

Access rights are normally managed from the administration view in Episerver CMS, but you can give editors the right to manage access rights for a single page in edit view.

🔍 You can watch the following demonstration video, Managing access rights. (6:39 minutes)

Different types of access

You can grant or deny the following types of access to users and groups: Read, Create, Change, Delete, Publish, and Administer.

<table>
<thead>
<tr>
<th>Access right</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read</td>
<td>The user or group can access the content as a reader; otherwise the content is invisible.</td>
</tr>
<tr>
<td>Create</td>
<td>The user or group can create content under the content item on which this right is set.</td>
</tr>
<tr>
<td>Change</td>
<td>The user or group can access the content to modify it. Typically, Create and Change are set together but there may be cases where you want someone to modify created content (but not create their own content), or vice versa.</td>
</tr>
<tr>
<td>Delete</td>
<td>The user or group can delete the content.</td>
</tr>
<tr>
<td>Publish</td>
<td>The user or group can publish the content.</td>
</tr>
</tbody>
</table>
| Administer   | The user or group can set access rights and language properties on individual content items from edit view for content given this access.  

**Note:** This does not provide access to admin view (for this you need to be a member of the WebAdmins group, see section Built-in user groups below).
**Access rights to assets**

Just as for pages, access rights can be applied to assets, such as folders, blocks and media, in the content structure. You can define specific access rights from the "Root" level and all the way down, including the **Recycle bin** (Trash) and **For All Sites** that stores blocks and media. Note that blocks and media share the same folder structure.

*If you want to automatically publish media that are uploaded to the website, editors who upload must have **Publish** access rights in the folder (under **For All Sites**) to which the media are uploaded. Also, editors must have **Create** access rights in the **root** level of the website to create blocks.*

**Set Access Rights for "Alloy Track targeted"**

Restore access rights in EPiServer CMS for items that you have, for example, completely removed access to. You can change all rights on all items.

**Add Users/Groups**

<table>
<thead>
<tr>
<th></th>
<th>Read</th>
<th>Create</th>
<th>Change</th>
<th>Delete</th>
<th>Publish</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Administrators</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Everyone</strong></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Site Editors</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Inherit settings from parent item**
- **Apply settings for all subitems**

**Should I set access rights for a single user or for a group?**
You can set access rights to content for a single user. For example, you can set the access rights so only Ann (and system administrators) can edit the Book a Demo page. You can add Ann to any number of pages and content, and set Ann’s access rights to each content item the same (or differently) for each page.

If you have a number of users that should have common access to content, managing access rights on a user-by-user basis can become complex. You should create user groups that have similar access needs, add the users to each user group, and then use the user group to set access rights to content. This lets you manage access rights more easily. You can add a user to one or more groups.

For example, add users Ann, Bob, and Cam to a Marketing user group and give access rights to any number of pages and content to the Marketing group instead of each individual. To add Dan to all of the Marketing content, (or remove Ann), you modify the Marketing user group. You do not have to visit each page or content item to update each individual user’s access rights.

**Built-in user groups**

A standard installation of Episerver has built-in user groups that align with user roles. You can extend predefined groups and roles; see Managing users and user groups.

> When your website is set up during development, the membership and role providers available for your website need to be configured to use the built-in groups and roles in Episerver.
**Group** | **Description**  
--- | ---  
Administrators | Comes from Windows and is defined when the website is created. An administrator can access all parts of the system, and can edit all website content. Often, administrators are developers setting up or maintaining the website.  
WebAdmins | Comes with Episerver and can access both admin and edit views and the administration interfaces for add-ons and visitor groups. To use this group, you must add it through admin view > Admin tab > Administer Groups > Add > WebAdmins.  
**Note:** Membership in WebAdmins does not provide editing access in the content structure by default. In most cases, only a few system administrators or “super users” belong to this group.  
WebEditors | Comes with Episerver and can access the editing view. To use this group, you must add it through admin view > Admin tab > Administer Groups > Add > WebEditors.
<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Add users to this group who need access to the edit view. Then add the users to other groups to give them specific edit rights to content. On large websites, editors are often organized in groups according to content structure or languages.</td>
</tr>
<tr>
<td>Everyone</td>
<td>Comes from Windows and provides “anonymous” visitors with read access to website content. All unregistered visitors to a public website are anonymous, meaning that they cannot be identified by the system. Removing access rights for the Everyone group, requires login to access content even if it is published.</td>
</tr>
</tbody>
</table>

**Setting access rights**

1. Go to admin view > **Admin** tab > **Set Access Rights**. The Set Access view appears with a content tree structure of the website.
2. Click on a node in the content tree (for example, **Marketing**). Typically, a content item shows **Administrators** (with all access rights) and **Everyone** (with Read only access rights). You can change these rights or add new users or groups.
   - If the users or groups are inactive (grayed out) for a content item, then the content item inherits the access rights of its parent content item. To set access rights for this content item, clear the **Inherit settings from parent item** check box.
   - To add settings to the selected node’s subitems without affecting their existing settings, select the **Apply settings for all subitems**; see section Setting access rights for all subitems below.
3. Click **Add Users/Groups**. A dialog box appears.
4. Select the type you want: **Users**, **Groups**, or **Visitor Groups**.
5. Leave the **Name** field blank and click **Search** to display all items of the type you selected. You can also type one or more characters in the **Name** field to filter and display a subset of items. (You can also search for a user by E-mail address.)
6. Double-click a user or group in the Existing box to move it to the Add box and click **OK**.
7. Modify the access rights settings as you want them and click **OK**. The users or groups appear in the Set Access Rights view for the selected content tree item.
If you set conflicting access rights to content, selected access rights prevail over cleared access rights. For example, Ann is a member of both the Marketing and Support user groups which each have different access rights set on the same content; Marketing has Publish rights, but Support does not. Ann, who is in both groups, has Publish rights to the content, but Bob, who is part of the Support group only, does not have Publish rights.

**Setting inheritance for content subitems**

Content inherits access rights from its closest parent item by default. When you set access rights for a content item, the rights apply to it and all subitems that have a selected Inherit settings from parent.
item option; subitems with this option cleared are not affected. For example, Alloy Plan, Alloy Track, and Alloy Meet all have the same access rights because they inherit the access rights from the Start page.

If you break inheritance for Alloy Meet and change the access rights on it, the access rights become different from the parent (Start) and its two siblings (Alloy Plan and Alloy Track).

If you then add a Marketing group group to Start, Alloy Plan and Allow Track inherit the Marketing group (because inheritance is selected) but Alloy Meet does not because its inheritance is unselected.

The following image shows the access rights for the Marketing content; it will not inherit from the parent item and any changes of access rights on Marketing will not be pushed to subitems unless they have the Inherit settings from parent item option selected.
Campaigns is a subitem of Marketing. It has Inherit settings from parent item selected, so the access rights are identical to that of the Marketing content item.
Book a demo is also a subitem of Marketing, but contrary to Campaigns, it has Inherit settings from parent item cleared, so its access rights are not the same as the Marketing parent content item. (Ann does not show up, and Zach is listed in the access rights.)
Setting access rights for all subitems

Selecting the **Apply settings for all subitems** check box applies the access rights of the parent item to all its subitems, even if a subitem has inheritance cleared. The option adds settings to a subitem that it did not have before and does not change or remove any existing settings on the subitem.

For example, the *Marketing* content item has *Ann* as a user with access rights.
When you select **Apply settings for all subitems**, *Ann* is added as a user with access rights to *Book a demo* because *Ann* is part of the *Marketing* content item's access rights. *Zach*, who already had access rights to *Book a demo*, remains on the list of access rights, unchanged.
If a parent item and a non-inheriting subitem have the same user or group, and the access rights for the user or group differ between the parent and the subitem, the parent's settings are applied when you select **Apply Settings for all subitems**. For example:

- If the *Marketing* parent item has user *Ann* with only *Read* access set, and *Book a Demo* has user *Ann* with all access rights set, then **Apply Settings for all subitems** resets Ann's access rights on *Book a Demo* to only *Read* access.
Conversely, if Marketing has user Ann with all access rights, and the subitem has user Ann with only Read access, Apply Settings for all subitems gives user Ann all access rights on the subitem.

Removing a user or group from the access rights list

To remove a user or group from the access list, clear all of the access rights for that user or group and click Save.

Using a visitor group in an access rights list

Visitor groups are used by the personalization feature, and you need administration access rights to manage visitor groups. If you want an editor to manage visitor groups without providing access to the entire admin view, you can make the editor a member of VisitorGroupAdmins. This group provides access only to the Visitor Groups option in the global menu. VisitorGroupAdmins comes with Episerver but you must add it through admin view > Admin tab > Administer Groups > Add > VisitorGroupAdmins.

You can set specific access rights for visitor groups, letting them view specific “hidden” content that is not otherwise publicly available. For example, you may want only members of the Visitors from London visitor group to have access to a Family day at the zoo page with a discount coupon.

This feature is useful if you want to create a “customer area” for registered customers on your website. Being a member of a visitor group requires a registration and login to access the content.

2. Select a node in the content tree.
3. Click Add Users/Groups.
4. In the Type drop-down list, select Visitor groups and click Search while leaving the Name field blank to view available visitor groups.
5. Double-click on a visitor group to move it to the Add box. Click OK.
Visitor groups can have read access only.

**Access rights for languages**

If your website has content in multiple languages, you can define access rights for languages so editors can create content only in languages to which they have access. Only users with access rights for a
language have it available on the Sites tab, and can create and edit content in that language. See Managing website languages.

### Add-ons Access rights for add-ons

Add-ons are plug-ins for extending Episerver functionality.

If you want an editor to manage add-ons without providing access to the admin view, make the editor a member of PackagingAdmins group which provides access only to the Add-ons option in the global menu.

PackagingAdmins comes with Episerver but you must add it through admin view > Admin tab > Administer Groups > Add > PackagingAdmins.

Some add-ons also may have specific user groups defined to access the functionality. See the documentation for each add-on in the online user guide to find out more.

### Commerce Access rights for Commerce

If you have Episerver Commerce installed on your website, see the Commerce access rights section in the Commerce User Guide.

### Find Access rights for Episerver Find

If you have added Episerver Find to your website, see the Find access rights section in the Find User Guide.

### CMS Managing users and user groups

For easier and safer maintenance, you should base access rights on user groups rather than individual users.

You can administer user credentials in the following ways:

- Manage users and user groups from the CMS administration view.
- Manage users and user groups in Windows.
- Develop a customized role and membership provider.

Users and groups created in the Episerver CMS admin view are available from admin view only; they are not accessible from Windows. You cannot add users created in Windows to groups created in Episerver. See the technical documentation on Episerver World for information about working with membership and role providers.
Smaller organizations with few editors tend to use the CMS administration view, whereas larger organizations with many editors tend to use the other options. You can combine these options.

**Creating, editing and deleting users**

To add a user in the CMS, do the following:

1. On the Admin tab, select Create User.
2. Specify a username, password and email address and set the account to Active.
3. Select none or more user groups to which the user should belong and click the arrow (or double click) to place the selected groups in the Member of box.
4. Under the Display Options tab, you can specify a default language for the user interface (optional) and touch support.
5. Click Save.
To edit user settings, search for the user under **Search User/Group** and then click a user name. You can modify properties only for users that are created via self-registration or via **Create User** in CMS.

To delete a user, search for the user under **Search User/Group**, click a user name to edit the settings, and click **Delete**. You cannot undo a deletion of a user.

**Displaying members of a user group**

Select the **Search User/Group** option to display groups and users.
» **Group view.** Click the desired group name to see members in the group.

![Administer Groups](image)

<table>
<thead>
<tr>
<th>Group</th>
<th>Provider</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marketing Group</td>
<td>SqlServerRoleProvider</td>
<td><img src="image" alt="Delete" /></td>
</tr>
</tbody>
</table>

**Users of group “Marketing Group”**

<table>
<thead>
<tr>
<th>Name</th>
<th>Provider</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ann</td>
<td>SqlServerMembershipProvider</td>
<td><img src="image" alt="Delete" /></td>
</tr>
<tr>
<td>Bob</td>
<td>SqlServerMembershipProvider</td>
<td><img src="image" alt="Delete" /></td>
</tr>
<tr>
<td>Cam</td>
<td>SqlServerMembershipProvider</td>
<td><img src="image" alt="Delete" /></td>
</tr>
</tbody>
</table>

» **User view.** Click on a user name to display the **Edit User** panel where you can modify group memberships and other user settings.
To see all users or groups, leave the **Name** field blank.

To see a subset of users or groups, type one or more letters in the **Name** field. Any names that have the string in them appear in the list.
Creating and deleting groups in CMS

When you select Administer Groups in admin view, all groups are shown irrespective of the provider used on the website. The group provider is shown next to the group name.

» Click Add to create a user group, enter a name, and save your changes.
» Click Delete to delete a user group.

You can delete only user groups that were created from the CMS. You cannot recover a user group after you delete it.
You cannot change the name of an existing group. Instead, delete the group and add a new one.
Scheduled jobs

A **scheduled job** is a service performing a task (job) at a given time interval. An administrator can start a job manually. A standard installation of the Episerver platform with Episerver CMS and Episerver Commerce includes several scheduled jobs. Some are enabled by default with preset values. You can develop customized scheduled jobs for specific website tasks.

**Administering scheduled jobs**

Manage scheduled jobs as follows:

1. Log in as an administrator and go to the Episerver CMS admin view.
2. Select the desired scheduled job on the **Admin** tab > **Scheduled Jobs**.
3. Select the **Active** box to activate the scheduled job.
   - To run the scheduled job automatically, set the desired time interval in **Scheduled job interval**. Each scheduled job’s run time appears in the **Next scheduled date** field.
   - To run the scheduled job manually, click **Start Manually** and the job is executed immediately.
4. Click **Save**.

The **History** tab lets you monitor the status and results when a scheduled job is executed. If a job fails, information about it appears under the **Message** column.
Built-in scheduled jobs

Archive Function

You can set how often the system archives information after the publication period expires with the Archive Function job.

- There can be a delay between the time information is unpublished, and when it appears in the archive. This may occur if the archiving job is run only once a day.

Automatic Emptying of Trash

You can set up how often your trash gets emptied with the Automatic Emptying of Trash job. With automatic emptying, all content in trash older than 30 days is permanently deleted by default. Trash also can be permanently deleted manually.

- The job is enabled by default, and set to run weekly.

Change Log Auto Truncate

You can delete items from the change log that are more one month old and do not have any dependencies registered against them by another part of Episerver CMS (for example, Mirroring) with the Change Log Auto Truncate job.

- The job is enabled by default, and set to run weekly.

Clear Thumbnail Properties

You can clear generated thumbnail images in the Products list and Media list views and add them again with the Clear Thumbnail Properties job. Run this job manually if you experience problems with refreshing thumbnails, such as on the website and BLOB-supported content.

Link Validation

You can check links on your website to identify broken links with the Link Validation job. The system tries to contact the target for the link to verify that it is responding.

- Links are returned only if they are unchecked or checked earlier than the time when the job started. The job continues until no more unchecked links are received from the database. If a large number of consecutive errors is found for external links, in case of a general network problem with the server running the site, the job stops.

- The result of the link validation job is a report called Link Status, in the Episerver CMS Report Center.

Marketing Test Monitor
The Marketing Test Monitor job handles the starting and stopping of A/B tests based on their start and end dates. If the Automatically publish the winner setting has been enabled, the scheduled job also automatically publishes the winning variant when an A/B test completes, given that the calculated test result is statistically significant with the required confidence level. See A/B Testing configuration in Tool settings for more information on this setting.

The job is enabled by default (if you have the A/B Testing feature installed), and set to run every 30 minutes.

Mirroring Service

You can set the frequency of mirroring content between websites with the Mirroring Service job. If your website is set up to mirror content between websites, you can manually mirror content or automatically do so at specific intervals. See also Mirroring.

Monitored Tasks Auto Truncate

The Monitor Tasks Auto Truncate job truncates the status of monitored tasks. It is a clean-up job that deletes 30 days of statuses of monitored and completed jobs.

The job is enabled by default, and set to run weekly.

Notification Dispatcher

Set the Notification Dispatcher job to determine how often Episerver CMS sends notifications of new or updated comments or replies posted in projects by a notification provider (for example, an email provider). Notification messages are sent to:

- users who are tagged in a comment or reply
- users who receive replies to their comments
- users who receive comments on their project actions (such as setting a project item to Ready to publish)
- other users who have previously replied to the same comment

A notification is not sent if no new comments or replies were posted since the job last executed.

The job is enabled by default, and set to run every half hour.

Notification Message Truncate

The Notification Message Truncate job truncates or deletes 3 months old notification messages that could not be sent and are still in the system.

The job is enabled by default, and set to run every day.

Publish Delayed Content Versions

The Publish Delayed Content Versions job lets you define how often the system checks for content
versions with a specific future publication date and time.
The job is enabled by default, and set to run hourly.

Remove Abandoned BLOBs
Episerver CMS can store media files in a cloud service instead of the website’s database. When you delete CMS files, this job makes sure the stored data is deleted from the BLOB provider.
The job is enabled by default, and set to run weekly.

Remove Permanent Editing
You can clear the Permanently Mark as Being Edited marking of pages in the edit view (if editors have forgotten to remove the marking) with the Remove Permanent Editing job.
The job is enabled by default, and set to run hourly.

Remove Unrelated Content Assets
You can delete content folders that contain media related to deleted content items with the Remove Unrelated Content Assets job.
The job is enabled by default, and set to run weekly.

Subscription
The Subscription feature lets visitors set the frequency for receiving subscription information. This job checks for information from the system to be included and distributed in the subscription send-out.

**Commerce** Commerce-related scheduled jobs
Installing Episerver Commerce adds scheduled jobs to your implementation. See Scheduled jobs in the Commerce user guide for information.

**Find** Episerver Find-related scheduled jobs
See Administration and configuration in the Episerver Find user guide for information about scheduled jobs for Find.

**Other scheduled jobs**
Customized modules and add-ons may have their own specific scheduled jobs. See the technical documentation for each module to find out more.
Managing custom content types

The edit view in Episerver only displays the default content types, such as pages, blocks, media, and products. Your website may have been set up with custom content types (that are implementing IContent) and these are not accessible via the navigation and assets panes in edit view. However, they are accessible from admin view > Admin > Tools > Manage Content.

Browse to the content item you want to change and select one of the options:

- **Edit content.** Opens the item in the edit view and you can edit it as any default content item.
- **Manage access rights.** Opens the Set access rights dialog box for the specific item. For details on access rights and how to change them, see Access rights.
- **Delete.** Deletes the item. It is not possible to restore the item.
- **Move to trash.** Moves the item to trash. From trash, you can restore the item as long as the scheduled job, **Automatic Emptying of Trash**, has not run.
Exporting and importing data

You can export and import data between Episerver websites. This function is widely used by developers building new functionality in a test or development environment. When you complete work and the information is ready for the production environment, use the export and import features to transfer the data between websites.

Exporting data

You can export the following: content items, content types, frames, dynamic property definitions, tabs, categories, files, and visitor groups.

Select a type of item to export, to display the available items of that type.
To export content items

1. Select **Export content items**, and then an item to export in the tree structure. If your content items contain multiple language versions, all language versions are included in the export package.
2. Optional: Select any of the three check boxes:
   - **Include sub items.** Exports the item’s children as well.
   - **Export files that the pages link to.** Exports global assets (such as blocks and images etc) that the selected item links to.

   **Note:** Local assets (saved under For this Page) are always included in the
export.

- **Automatically export dependent content types.** This option is mostly used for older untyped pages, and specifies that the content type is included in the export. For newer, typed pages or if the import website already has this content type, it is not necessary to select this option.

3. Click **Export** to download the file package. Your export package is saved to your web browser’s default download location.

- To update a single content item through export and import; deselect **Include sub items** and export the item. Then import the item and make sure **Update existing content items with matching ID** is selected.

### Importing data

With the **Import Data** function, you can retrieve information exported from the same or another Episerver website.

1. Select the file package to import. Files must end with `*.episerverdata` for the import to work.
2. Click **Upload and Verify File** to verify the file content. The files are read and checked, and verification information is displayed.
3. Select the destination for the imported files.
4. Select or deselect **Update existing content items with matching ID**:
   - Select the check box if you want to keep the same GUIDs for imported items (such as pages, blocks and files) as they had on the exporting site. The import checks whether a
GUID already exists and, if it does, that item is updated (if the imported item had a changed date that is later than the existing item). This means that content items with the same IDs are replaced instead of added.

If your exported pages contained links to global blocks and media, you must select **Export files that the pages link to** when exporting, for the linked global blocks and media to be updated during the import.

Deselect the check box if you want to import items with new IDs instead. If you import to the same website as you exported from, blocks and media are merged into folders with the same name in the assets pane.

Duplicated items get a number added to the item name. For example, exporting item *ABC* and importing it as a copy on the same website results in two items, namely *ABC* and *ABC2*. This also affects the URL, which in the case of the copied item would be **www.example.com/abc2**.

5. If your export package contains multiple language versions, select **All** if you want to import all language versions or one specific language to import only that language version.

6. Click **Begin Import**.
CMS System settings

System settings let you define certain settings for the Episerver CMS installation, for instance, to activate globalization, change the error handling, and configure version management of content.

General tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error handling in Episerver CMS</td>
<td>Select how you want errors to be handled; active for all visitors, remote visitors, or disabled.</td>
</tr>
<tr>
<td>Handler for subscription updates</td>
<td>The subscription function in Episerver lets visitors receive information about new and updated pages. Depending on whether multi-language is supported, you can select how the subscription dispatch is managed. This list also can include your own solutions for the subscription function.</td>
</tr>
<tr>
<td>Encrypt the connectionStrings.config file</td>
<td>Select to encrypt the connectionStrings.config file, which contains sensitive information sent to and from the database.</td>
</tr>
<tr>
<td>Enable globalization</td>
<td>Select to activate management of content in multiple languages (globalization).</td>
</tr>
<tr>
<td>Detect language via browser's language preference</td>
<td>Select to activate languages to be shown based upon the visitor's browser settings.</td>
</tr>
</tbody>
</table>
**Setting** | **Description**
--- | ---
**Disable deletion of content versions** | Select to disable the ability of editors to delete versions of pages, blocks and files. Selecting this also disables the automatic deletion of versions caused by the **Maximum number of versions** field on the **Editing** tab.

**Editing tab**

**Setting** | **Description**
--- | ---
**Path to CSS file for the rich-text editor** | Controls the styling options (such as heading levels etc) available to the editor in the rich-text editor. This can be the same or similar CSS file as the site uses for styling content so that the editors get the same appearance as the site when editing content.

**Maximum number of versions** | Specify the number of previously-published versions of content items (for example, pages or blocks) that are stored. The currently-published version and draft versions are not counted. For example, if you enter 3, Episerver CMS stores three previously-published versions. If that is the case for a content item and you publish a new version, the oldest version is removed. Default value is 20 versions. This field is ignored if the Unlimited versions or Disable deletion of content versions box is selected.

**Unlimited versions** | Stores an unlimited number of versions of content items (such as pages or blocks). This option may result in a large version list, which can be difficult to use unless you manually delete unwanted versions. If you check this, the value in the **Maximum number of versions** field is
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Auto publish media on upload  | Select to automatically publish and index media when uploaded to the website. **Note:** If a user uploads media but does not have publishing rights in the folder to which the media is uploaded, then the uploaded documents are not published (images, for instance, are not displayed when used in content). Ensure that editors who upload media also have the proper access rights set in the media folder structure.  

Also **note** that if this check box is selected and a user (with the proper access rights) uploads media, it is published and indexed immediately, so can be found by search engines, even if no published page contains links to the media.  

If the projects feature is enabled in your system, this setting is ignored. Uploaded media that is associated with a project is not published until it is manually published or published via scheduling, even if this setting is turned on. |
Managing websites

You can easily add and remove websites from an Episerver installation, perhaps to create short-lived campaign websites.

On the Config tab > Manage Websites, you can see an overview of existing websites in your installation. These websites share the same database, content types and templates, making it easy to set up new websites. You can also define whether content, such as blocks, folders, and media, should be shared or site-specific.

You can add new websites in the following ways:

- **Single-site setup** lets your installation have one CMS site mapped to one IIS instance. The IIS mapping is with a wild card or a specific host name. You can have several single sites with separate databases and code base on the same server. In that case, you have a separate admin interface for each site.

- **Multi-site setup** lets you have a single CMS site as a base (default site), and can create new sites in admin view that share the same root page, database and code base. The additional sites are either automatically mapped and require no additional configuration (if the base site is mapped to wild card), or they need manual configuration of host name.

When you work in a multi-site setup, you see all sites in the same interface, which makes it easy to work with them. One reason to run a multi-site setup with specific host name mapping (that is, a different IIS instance per CMS site) is that you can use different application pools, which means that if one site fails, the other sites continue to run.

**Requirements**

The following requirements must be met to manage websites in admin view:

© Episerver 2017
Available licenses. A notification message informs you of the number of sites allowed by the license available for the installation. See License Information on the Admin tab for information.

Unique URL. In admin view, each website must have a unique URL and start page in the content tree. Start pages cannot be nested.

Domain mapping must be configured in IIS.

- For multi-site setup, the IIS must be configured to respond to any host name.
- For single-site setup, each separate CMS site must have an IIS site configured.

Adding and updating a website from admin view

On the Websites tab, you can click a site to see detailed information about its settings. From here, you can also update the site information.

To add more sites to your installation, click Add Site. Add the following information when creating and updating site settings for your installation:

<table>
<thead>
<tr>
<th>Site setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a name that identifies the website, such as Example Site.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the URL for the site, such as <a href="http://examplesite.com">http://examplesite.com</a>. If your site is</td>
</tr>
<tr>
<td></td>
<td>using unicode characters in the URL segments, internationalized domain</td>
</tr>
<tr>
<td></td>
<td>names should be registered in punycode format. See also Internationalized</td>
</tr>
<tr>
<td></td>
<td>Resource Identifiers (IRIs) on Episerver World.</td>
</tr>
<tr>
<td>Start page</td>
<td>Select the page to which the visitor is sent if only a host name is</td>
</tr>
<tr>
<td></td>
<td>specified.</td>
</tr>
<tr>
<td>Use site-specific assets</td>
<td>Select this check box to ensure that assets, such as blocks and media, for</td>
</tr>
<tr>
<td></td>
<td>this site are not available for use on other sites in the installation.</td>
</tr>
<tr>
<td></td>
<td>This option affects the folder structure editors see in the assets pane.</td>
</tr>
<tr>
<td>Host name</td>
<td>Optional. Enter a specific URL, such as examplesite.com. If you do not</td>
</tr>
<tr>
<td></td>
<td>name the website, it is automatically named with the URL you have entered.</td>
</tr>
<tr>
<td></td>
<td>One of the sites in the installation must be bound to the * host name.</td>
</tr>
<tr>
<td></td>
<td>That site is used as a fallback when an exact match for the host name used</td>
</tr>
<tr>
<td></td>
<td>by the visitor cannot be found. This setting is less important in a single-</td>
</tr>
<tr>
<td></td>
<td>site scenario, because you can have only one site configuration. However,</td>
</tr>
<tr>
<td></td>
<td>in a multi-site scenario, you must make sure that host bindings active in</td>
</tr>
<tr>
<td></td>
<td>IIS are mirrored in the corresponding site configuration. For example, you</td>
</tr>
<tr>
<td></td>
<td>want to add examplesite.se. Usage: The host name list is evaluated by the</td>
</tr>
<tr>
<td></td>
<td>application in two different scenarios:</td>
</tr>
<tr>
<td></td>
<td>Request routing. When serving a request, the application evaluates</td>
</tr>
</tbody>
</table>

© Episerver 2017
<table>
<thead>
<tr>
<th>Site setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the host list to see which site and language (culture) that should be served.</td>
</tr>
<tr>
<td></td>
<td><strong>Cross-site linking.</strong> When generating links to another site or culture, the host list is evaluated to find the host name to use for constructing the link URL.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A wildcard * mapping must always be accompanied by an explicit host name to support cross-site link generation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Culture</th>
<th>Select the default language for when a visitor accesses the website using the host name.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th><strong>Primary host.</strong> A primary host is the preferred host name when generating links between sites or languages (cultures). If no host is defined as primary, the first non-redirected host and non-edit host is used. You can define only one primary host per language plus one primary that is unbound to any language.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Edit host.</strong> An editing host is the preferred host name to use when editing a site. This host name is used for all links between sites when the users are in the editing view. If no editing host is defined, the primary or first found host is used. You can define only one editing host per site and you cannot bind it to any language. Users are not forced to the edit host for editing and remain on their current host if the editing view is requested from another host on the site.</td>
</tr>
<tr>
<td></td>
<td><strong>Redirection host.</strong> A redirection host defines that requests using this host name are redirected to a different host name. Such requests are redirected to the primary host or, if none is defined, the first non-redirected host found. You can set redirection to permanent or temporary, which determines the type of HTTP redirect status that should be used. Redirected host names are never used when generating links. There can be any number of redirection hosts defined as long as there is at least one primary or standard host name bound to the same language.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scheme</th>
<th>Select the preferred scheme to be used for this host. This affects only the generation of links to the site as incoming requests are matched to the host name regardless of scheme.</th>
</tr>
</thead>
</table>

**EXAMPLE:** Default website with different host names, languages and redirection types
The following example shows a default website with several host names, languages and redirection types configured:

This example would lead to the following behavior:

- A request to http://redirected.se is redirected to http://examplesite.se using an HTTP 301 response.
- A request to http://www.examplesite.se is served the Swedish content.
- Canonical links added in the templates should point to http://examplesite.se
- A request to http://redirected.no/page/ is redirected to http://examplesite.no/page/ using an HTTP 301 response as this is the only Norwegian host that is not redirected.
A request to http://redirected.com is redirected to http://examplesite.com using an HTTP 302 response as per the wild card specification.

EXAMPLE: Campaign website

The following example shows a campaign website:
Managing website languages

Editors can create content in a particular language after you add and activate the language, and set an access level for a language. This prevents unauthorized editors from creating or editing pages in that language.

Language overview

Go to the **Config** tab > **Manage Website Languages**. The installed website languages appear. You can see which languages are enabled for active editing in edit view, and the order in which languages are available. You can adjust the order of the languages using the arrows to the left of the language. To change a language’s settings, click its name.

Adding and enabling languages

Before an editor can edit content in different languages, you need to add and enable the languages in the admin view and then enable them for editing in the CMS edit view.

1. Adding and editing languages
a. On the **Config** tab, select **Manage Website Languages**.
b. Click a language to edit its settings, or click **Add Language** to add a new language. A list of available language codes appears. Select a language code by clicking the name.
c. In **Name**, enter a name for that language to be shown in the edit view. The field contains the name of the language encoding, but you can change this if you want.
d. Select **Enabled** if you want the language to be active for editing in edit view. This option also affects whether the language is available to website visitors. A disabled language is not visible in the edit view. Existing content in that language is still accessible, but it cannot be edited.

e. In the **Template icon** field, enter the path to an icon that symbolizes the language. Several flags are stored in the `C:\Program Files\Episerver\CMS\<release>\Application\App_Themes\Default\Images` folder. If you want to make your own icons, they should be 15x15 pixels so they fit properly in the edit view.
f. In the **Web address prefix** field, you can provide a specific prefix to show the content of the relevant language. If you do not provide a prefix, the language code is used, such as `www.company.com/nl`.
g. Use **Access level** to define which editor groups should have access to create and edit content in this language (see below). When you add a language, it is available for the **Everyone** group by default. Only users with access rights for a language have it available on the **Sites** tab, and can create and edit content in that language.
An editor’s create and edit access rights to content and language determine which actions the editor can perform on the content. This means that an editor must have edit access for a specific language and a specific item to edit the content in that language.

When a language has Everyone as access rights, access rights for an item apply to all languages. This also means that an editor with delete access rights for content can delete an entire node with content in all languages, including content in languages to which the editor does not have access.

If you remove the Everyone group in a certain language, it may cause some editors to lose their access rights to create and edit content in that language.

h. Click Save.

2. Enabling a language on a website (if not already done)
   a. In the admin view, go to the Config tab > Manage Website Languages.
   b. Click on the desired language in the list.

   c. Select the Enabled check box and click Save.

3. Enabling a language for editing in CMS

This step makes the language available for content creation by editors. A language can be made
available for the entire site structure, or for parts of it. By default, subpages inherit language settings from their parent page.

a. In the CMS page tree, select the root page for the branch for which you want to enable the language. In this example, we want "French" to be available for the entire site, so the language setting is defined on the start page.
b. Open the page in All Properties editing.
c. Select Tools and Language Settings in the header.
d. Under Available Languages, select Change.
e. Select the language you wish to enable, click Save, and close the dialog.

f. For a correct display, the website start page also needs to be available in the new language. To do this, switch to the newly activated language, go to the start page, select Translate, then publish it.
Once the language has been enabled as described above, it is available for content translation in the Episerver CMS Editor Guide.

**Deleting an existing language**

You should remove a language from the website by opening the language for editing, and clearing the **Enabled** option.
Managing content approval sequences (Beta)

This feature is released as a Beta feature, which means that it is under development.

Using content approvals in Episerver CMS is a way to make sure that content is reviewed and approved before it is published. If content approvals have been defined for an item, the editor cannot publish it but has to set it as **Ready for Review**. One or more appointed reviewers must then approve the content item before it can be published. The reviewers are defined by an administrator in an **approval sequence**. For a more detailed description of content approvals from an editor's perspective, see the Content approvals chapter in the CMS Editor User Guide.

You define an approval sequence for a specific page in the page tree or for a global or site-specific assets folder in the assets pane. You can then choose to let the item’s or folder’s children inherit the approval sequence, create a new approval sequence for the children or disable approval sequences for the children. For detailed information how content approval sequences work on assets, see **Content approvals on assets**.

The approval sequence overview is opened from a page’s or assets folder's context menu:

In the approval sequence overview, you define the number of approval steps, you can have as many as you like, and also the persons responsible for review and approval in each of the steps.
Content approvals on assets

Each page in Episerver can have its own content approval sequence. Assets, such as blocks and media (and also forms and catalogs if you have Episerver Forms and Episerver Commerce respectively installed), cannot have individual approval sequences. Instead, the content approval sequence is set on each assets folder, and all assets in a folder have the same approval sequence set. Global and site-specific assets folders can either inherit their approval sequence from a parent folder (up to the site root), or an administrator can define a unique sequence for it (or disable it completely so that assets in the folder do not have to be approved). If there are no sequence set on a parent item, they inherit the disabled state.

Blocks and media in global (For All Sites) and site-specific (For This Site) folders inherit the content approval sequence from the parent node by default. Note that they inherit from the site root, which is not the same for global and site-specific folders. The global assets folders inherit from Root, while site-specific assets folders inherit from the site's root, that is Start in the
Local assets folders always inherit their approval sequence from the page they are associated with.

See also Folders in the CMS Editor User Guide for a description of global, site-specific and local folders.

What happens if I want to move folders or assets that have content approval sequences set?

Moving folders and assets that have content approval sequences set, works like the following descriptions.

**Folders**

- Moving a folder to another **global or site-specific folder**. The folder keeps its original approval sequence. You can move the folder even if items in the folder are in review.
- Moving a folder to a **local assets folder**. The folder’s approval sequence is changed to the local assets folder’s sequence. You cannot move the folder if items in the folder are in review.

**Assets**

- Moving an asset to a **global or site-specific folder**. The approval sequence on the asset is changed to the new folder’s approval sequence. You can move an item even if it is in review. However, in that case, it continues its original content approval sequence until it has been either approved or rejected. After that it has the same approval sequence as the new folder.
- Moving an asset to a **local asset folder**. The approval sequence on the asset is changed to the new folder’s approval sequence. You cannot move the asset if it is in review.
The Blocks and Media folders in the assets pane are actually the same folders in the software and share the same content approval sequences; the Blocks and Media tabs in the assets pane are merely a way of filtering out blocks if you are in the Media tab and vice versa. This means that if Adam is set as a reviewer on block folder *Bunnies*, Adam is also a reviewer of all media in media folder *Bunnies*.

As a result, if you edit a block in the *Bunnies* folder which links to images in the media folder *Bunnies*, and set the block to *Ready for Review*, the same content approval sequence is triggered also for the images.

Forms and catalogs have their own structures, so even if you have a Commerce catalog named *Bunnies*, it does not get the same content approval sequence as the *Bunnies* folders for blocks and media.

Assets added to an assets folder with a content approval sequence set are not auto published, even if the auto publish option is set (see Auto publish media on upload in the CMS Administrator User Guide).

**Content approvals on multi-language sites**

If you are working with a multi-language site, you can define different reviewers for the different languages in each step. Each language must have at least one reviewer, but it is recommended to have at least two reviewers per language.

Items, such as images, that do not have a language set can be approved by any reviewer (even by reviewers that only have access to a specific language).

You can view how the approval sequence is defined for all languages or for each language individually by using the **Display sequence for [language]** drop-down list.

**Setting up an approval sequence**

**Setting up an approval sequence (single language website)**

This section describes how to set up an approval sequence for one language. If your website uses multiple languages, see Setting up an approval sequence on a multiple languages website.
1. Open the approval sequence overview from an item's context menu (either in the navigation pane or assets pane).
2. In the first step, type the first letter of the reviewer's name. Select the reviewer from the list of suggestions.

![Step selection](image)

A reviewer must have at least **Read** and **Change** access rights to the item to be able to review and approve it.

3. Add at least one more reviewer to the step. You should always have at least two reviewers in each step, in case one of the reviewers is unable to review and approve.
4. Optional: Click **Untitled Step** to rename the step to something more descriptive, for example **Product marketing** or **ISO compliance review**.
5. Optional: To add more steps to the approval sequence, click the add button: +.
6. Click **Save**.

### Setting up an approval sequence for children items

When you have defined an approval sequence for an item, you can define if its children have to be approved or not.

1. Open the approval sequence overview from a child item's context menu.
2. Depending on how you want to set up the item's approval sequence, select one of the three radio buttons:
   - **Enabled**. This setting lets you edit and define the approval sequence any way you what. The approval sequence is not connected to the parent item's approval sequence. Set up the sequence in the same manner as described in the section above.
   - **Inherited**. This setting locks the approval sequence for the current item and it gets whatever settings its parent has. If the parent item's approval sequence is changed, so is the approval sequence for the current item.
   - **Disabled**. This setting disables the approval sequence for the item and it does not have to be approved.
Inherited is set by default, so if you do not define an approval sequence for an item's children, they automatically get the same approval sequence as the parent. If inheritance is set on children and the approval sequence is disabled on the parent item, the children inherits the disabled state. Local assets folders always inherits the content approval sequence set on the associated page or block.

Setting up an approval sequence on a multiple languages website

1. Open the approval sequence overview from an item's context menu.
2. In the first step, type the first letter of the reviewer's name. Select the reviewer from the list of suggestions.
3. Click the 🌐 icon and select the languages the reviewer should be able to approve in the Select Language drop-down list. A reviewer can approve content in one, several, or all languages.

:: Globalization review

<table>
<thead>
<tr>
<th>Mia Schaffer</th>
<th>de</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jacques Fressinet</td>
<td>fr</td>
</tr>
<tr>
<td>Emeline Kahn</td>
<td>fr</td>
</tr>
<tr>
<td>Paul Bachmann</td>
<td>de</td>
</tr>
<tr>
<td>Lucas Anderson</td>
<td></td>
</tr>
</tbody>
</table>

Select Language

- Any Language
- English
- Deutsch
- français

There is a difference between selecting Any language and selecting all languages one by one. If you select Any language, the reviewer can approve an item in any language it exists in, which also includes any new languages you may add in the future. If you
select all available languages one by one, these are the only languages the reviewer can approve content in. If you add a new language in the future, the reviewer does not have the rights to approve in that language.

4. Add at least one more reviewer to the step. You should always have at least two reviewers per language in each step, in case one of the reviewers is unable to review and approve.

5. Optional: Click Untitled Step to rename the step to something more descriptive, for example Product marketing or ISO compliance review.

6. Optional: To add more steps to the approval sequence, click the add button: +.

7. Click Save.

Editing an approval sequence

Open the approval sequence from the content item’s context menu and make sure that the Enabled radio button is selected. Edit and save the approval sequence as described in Setting up an approval sequence. You can rearrange the approval steps by drag and drop.

Note that if the selected content item has children that are set as Inherited, they will inherit all changes.

Approving and canceling approval sequences

As an administrator, you have the right to approve the entire approval sequence in one go, and to cancel a review request. You do that from the Options button.
Deleting an approval sequence

You cannot delete an approval sequence but you can disable it. Open the approval sequence from the item's context menu and select Disabled. The item can now be published immediately and does not have to be approved. Note that if the selected content item has children that are set as Inherited, these children do not have to be approved either.

Using notifications

The defined reviewers can get notifications in the user interface and by email notifying them of the requested approvals. For the notifications in the user interface to be instantly displayed, your web server needs to have WebSocket support enabled. See WebSocket support on Episerver World. For the email notifications to work, you need to configure your SMTP server with a from address. See Configuring your email server on Episerver World.
Creating categories

This topic is intended for administrators and developers with administration access rights in Episerver.

Episerver CMS, a category classifies content, such as for building filtering features for search and navigation. You create categories in admin view, and apply them to content in edit view.

A category is a built-in property in Episerver CMS. You can apply categories to content, but you need to build the customized functionality for your website to display the resulting outcome, such as in a filtering. Also, do not confuse content categories with Commerce categories; see Creating a catalog entry.

Adding a category

Add a new top-level category as follows:

1. From admin view > Config tab, select Edit Categories.

   ![Categories Table]

2. Click Add. A new row is added to the table.
3. Specify a name in the Name field. This name is used in code when building category-based functionality.
4. Enter a name in the Display name field. This name is visible in edit view when a user selects categories. You also can language-encode this field.
5. Select Visible if you want this category to appear in the Select Categories dialog box in edit view.
6. Select Selectable if you want this category to be selectable in the Select Categories dialog box in edit view.
7. Use the up or down arrows if you want to move this category higher or lower in the list. This sequence determines the order in which categories appear in the Select Categories dialog box.

8. If you want to add a subcategory to a top-level, select the plus sign under Add. Add the subcategory in the same way as the top-level category.

Deleting or changing a category

Depending on how a category is used on your website, changing or deleting a category may cause things to stop working. Check with your developer before changing or deleting a category.
Editing frames and tabs

Frames

If you implemented frames on your website, you can use them for opening a link in a particular area of the window. This topic defined frames that are used by the system, and are accessible in the edit view as an option when an editor assigns a target frame for linking of content. Select the Config tab, and then Edit Frames.

<table>
<thead>
<tr>
<th>Frame Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_blank</td>
<td>Open the link in a new window</td>
</tr>
<tr>
<td>_top</td>
<td>Open the link in the whole window</td>
</tr>
</tbody>
</table>

Tabs

You can make properties appear on different tabs by selecting the Edit Tabs function. From here you can add, edit and delete tabs. You can also define the display order for tabs, and apply access levels.
Adding and editing a tab

1. On the Config tab, select Edit Tabs.
2. Click Add to create a new tab. Click the Edit icon to edit a tab.
3. In Tab, name the tab.
4. In Sort Index, specify the index amount for the tab. The lower the value, the further to the left the tab is placed.
5. In Requires Access Level, you can select which access level should apply for an editor to see the tab. It is linked to the editor’s access level for the page.
6. Click Save.
Permissions for functions

Setting of access rights from Permissions for Functions

Set the access rights for the following functions, which are found in the admin view under Config > Security > Permissions for functions.

- **Detailed error messages for troubleshooting** provides selected groups or users access to detailed error messages whenever they encounter website failures.
- **Allow the user to act as a web service user** lets a user call one of the web services provided by Episerver. This function is used only for system integration purposes.
- **Allow users to move data/pages between page providers** lets selected users or groups move pages between page providers. This is used for websites with a custom page provider integrated with another system. Because data is deleted in the source provider, you may want to limit access to this function.

Adding/Changing permissions to a function for a group or user

1. In admin view, go to **Config > Security > Permissions for functions** and select **Edit** for the function you want to modify. Existing groups or users with access appear.
2. Select **Add Users/Groups** if you want to give users or groups access to this function. The groups and persons in the system appear in the window that opens.
3. Double-click the name to add the group or user.
4. Select **OK**. The group or user appears in the list with its check box selected.
5. Click **Save**.

Deleting permissions to a function for a group or user

1. In admin view, go to **Config > Security > Permissions for functions** and select **Edit** for the function you want to modify. Existing groups or users with access appear in a list.
2. Clear the check box of the group or user for which you want to remove access.
3. Click **Save**.

For information about working with access rights, see **Access rights**.
CMS Tool settings

In admin view, under Config > Tool Settings you can perform miscellaneous functions for the integration and configuration of Episerver CMS.

- Plug-in manager
- Change log
- Rebuild name for web addresses
- Mirroring
- A/B Testing configuration
- Search configuration

Plug-in manager

Many functions in Episerver CMS are created as plug-ins, which you can manage from the Plug-in Manager. You can activate and deactivate selected parts. If your organization invested in additional plug-ins, you can find them in the Plug-in Manager also. After choosing a plug-in, choose which parts of it are accessible in the Overview tab.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Version</th>
<th>Company</th>
<th>License</th>
<th>More Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPiServer Enterprise</td>
<td>Enterprise support for EPiServer CMS</td>
<td>9.5.1.0</td>
<td>Unknown</td>
<td>System internal</td>
<td><a href="http://www.episerver.com">http://www.episerver.com</a></td>
</tr>
<tr>
<td>EPiServer User Interface</td>
<td>Supporting logic for the built-in web forms and user controls</td>
<td>9.4.0.0</td>
<td>EPiServer AB</td>
<td>System internal</td>
<td><a href="http://www.episerver.com">http://www.episerver.com</a></td>
</tr>
<tr>
<td>EPiServer CMS MVC Template package</td>
<td></td>
<td>9.4.0.0</td>
<td>EPiServer AB</td>
<td>System internal</td>
<td><a href="http://www.episerver.com">http://www.episerver.com</a></td>
</tr>
<tr>
<td>EPiServer LinkAnalyzer</td>
<td></td>
<td>9.5.1.0</td>
<td>Unknown</td>
<td>System internal</td>
<td><a href="http://www.episerver.com">http://www.episerver.com</a></td>
</tr>
</tbody>
</table>

Change log

By default, all changes to pages, files and directories are logged in the Change Log system. You can filter the information in the Change Log, making it easier to find relevant information.

Changing the Change Log state
1. In admin view, select **Config tab > Tool Settings > Change Log**.

2. Select a state:
   - **Enabled**: The Change Log starts automatically when the site starts and is available for read and write operations.
   - **Disabled**: The Change Log does not start when the site starts. Items written to the Change Log are ignored, but items may still be read from the Change Log.
   - **Auto**: The Change Log starts as soon as any dependencies (such as a Mirroring Job) are registered against it. If no dependencies exist, the system does not start. If already running, it stops.

**Filtering the Change Log**

1. On the **View** tab, filter and view change log items by entering one or several of the following values:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change date from</td>
<td>The query is run from the change log from this date.</td>
</tr>
<tr>
<td>Change date to</td>
<td>The query is run from the change log to this date.</td>
</tr>
<tr>
<td>Category</td>
<td>From the <strong>Category</strong> drop-down list, select:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Page</strong> to run a query on pages only.</td>
</tr>
<tr>
<td></td>
<td>- <strong>File</strong> to run a query on files only.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Directory</strong> to run a query on pages directories only.</td>
</tr>
<tr>
<td></td>
<td>If you do not select an options from the drop-down list, changes are read from the <strong>Change Log</strong> when the query is run.</td>
</tr>
<tr>
<td>Action</td>
<td>You can filter the following actions in the Change Log:</td>
</tr>
<tr>
<td></td>
<td>- Check in</td>
</tr>
<tr>
<td></td>
<td>- Create</td>
</tr>
<tr>
<td></td>
<td>- Delete</td>
</tr>
<tr>
<td></td>
<td>- Delete language</td>
</tr>
<tr>
<td></td>
<td>- Move</td>
</tr>
<tr>
<td></td>
<td>- Publish</td>
</tr>
<tr>
<td></td>
<td>- Save</td>
</tr>
<tr>
<td></td>
<td>- Delete children</td>
</tr>
<tr>
<td>Changed by</td>
<td>To filter for a specific user, enter the Episerver CMS user name.</td>
</tr>
<tr>
<td>Maximum number of items per page</td>
<td>Limits the displayed number of items. Click the next and previous arrows to browse through the list of items.</td>
</tr>
</tbody>
</table>
### Field name | Description
--- | ---
**Start with sequence number** | Enter a specific sequence number to start listing the items in the change log.
**Read direction** | List change log items in either ascending or descending order.

2. Click **Read** to run the query. A list of matching change log items appear.

To remove all Change Log items that are more than one month old and without dependencies, use the **Change log auto truncate scheduled job**.

Website developers can customize and extend the Change Log. Consult your website developer for assistance.

### Rebuild name for web addresses

**Rebuild Name for Web Addresses** changes addresses in the address field. When a visitor views a page on a website based on Episerver CMS, a path to the page appears in the address field. The address reflects the page's place in the website structure.

![http://world.episerver.com/Documentation/]

The names in the address field are created automatically from the name an editor specified for the page. If an editor changes the page name, the name in the address field does not change. You can manually change name in the address field by changing the **Name in URL** field on the **Settings** tab in edit view.

Some pages have no value in the field for names in web addresses, such as pages imported from other Episerver solutions. The **Rebuild Name for Web Addresses** function lets you create all web addresses for the website at the same time. You also can overwrite all existing addresses with new ones.

- **The Rebuild Name for Web Addresses** function can affect links to the website. All internal links are updated automatically. However, if other websites link to a certain page, that link may be broken. The function also can affect visitors' browser favorites (bookmarks).

### Creating a rebuilding name for web address

1. On the **Config** tab, select **Rebuild Name for Web Addresses**.
2. Select **Rebuild all page names in web addresses (overwriting existing links)**.
3. Click **Rebuild Links**.

**Mirroring**

Mirroring duplicates content between websites. Episerver CMS can mirror selected parts or an entire website, and can run automatically or manually. This is useful if you wish to create sections in a test environment then publish all information at once to the public section.

Mirroring jobs are executed at time intervals that you set, as described in Scheduled jobs.

To enable mirroring, a mirroring application must be installed and running. The application handles data transfer between websites and is run separately to the Episerver CMS source and target sites. You can configure source and target websites to use separate mirroring applications. You also can install and configure a single mirroring application. See Episerver World for information about configuring and working with mirroring.
Creating a channel

To set up mirroring between two websites, create channels in the admin view. Channels define the mirroring jobs from one Episerver CMS to another, or even to an external recipient.

Go to the source site in admin view > Config tab > Tool Settings > Mirroring to create a channel for mirroring as follows:
1. Click **Create** and enter the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Type an unique name for the mirroring channel.</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>Optional field that can be used by providers. In this version, there is one parameter which can be handled by the provider: Episerver.MirroringService.MirroringTransferProtocol.WCF.MirroringTransferClient.TransferAction. The TransferAction has two options <strong>None</strong> and <strong>ForceCurrentVersion</strong>. By default, the value is <strong>None</strong>, which creates a new version for each published page on the target site. The <strong>ForceCurrentVersion</strong> option does not create a new version for each published page. Instead, it updates the page on the target site.</td>
</tr>
<tr>
<td><strong>Use default URI</strong></td>
<td>Select to use the URI defined in the configuration file (web.config) for the mirroring application. When you select this option, the <strong>URI</strong> field is disabled.</td>
</tr>
<tr>
<td><strong>URI</strong></td>
<td>Enter the URI to the destination mirroring application's target service, for example: <a href="http://localhost/Mirroring/Mirroring/MirroringTransferServer.svc">http://localhost/Mirroring/Mirroring/MirroringTransferServer.svc</a>. The service for the default provider is: MirroringTransferServer.svc.</td>
</tr>
<tr>
<td><strong>Start page</strong></td>
<td>Select the local root page on the source site to be mirrored.</td>
</tr>
<tr>
<td><strong>Root page on destination</strong></td>
<td>Select the page number on the target site where the pages are mirrored to.</td>
</tr>
<tr>
<td><strong>Include start page</strong></td>
<td>Sets whether the start page is mirrored or if only its children are mirrored.</td>
</tr>
<tr>
<td><strong>Import as anonymous user</strong></td>
<td>Sets whether an anonymous user does the export and import of pages and files when the mirroring job is run.</td>
</tr>
<tr>
<td><strong>Import content as user</strong></td>
<td>Sets whether an identified user does the export and import of pages and files when the mirroring job is run.</td>
</tr>
<tr>
<td><strong>Enable reporting</strong></td>
<td>Select to enable reporting for the mirroring job through email. When you</td>
</tr>
</tbody>
</table>
2. Click **Save**.

3. Continue with any of the following options:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reset Channel</strong></td>
<td>Select to mirror everything again from the root page of the mirroring channel to the source site next time it is run. To reset the channel, select the name of the mirroring channel and click <strong>Continue with Reset</strong>.</td>
</tr>
<tr>
<td><strong>Check System</strong></td>
<td>To validate the created channel, click <strong>Check System</strong>. The result appears under the <strong>Messages</strong> tab. It checks both the source and target site to see if all necessary parameters are set up correctly; such as URI, Root page at destination, Mirroring Server binding, and Access to Database. See the section about synchronizing mirroring in the <strong>Developer Guide</strong> under <strong>Deployment &gt; Mirroring &gt; Installing and Configuring mirroring</strong>.</td>
</tr>
<tr>
<td><strong>Messages</strong></td>
<td>The result of a check system appears in the <strong>Messages</strong> tab. Click the arrow to view the result and other information regarding previous mirroring jobs that were run.</td>
</tr>
<tr>
<td><strong>Monitoring</strong></td>
<td>The status of a mirroring job appears in the <strong>Monitoring</strong> tab.</td>
</tr>
</tbody>
</table>
### Configuring A/B Testing

You can configure the settings used when running A/B tests under **Admin > Config > Tool Settings > AB Testing Configuration.**

#### AB Testing Configuration

These settings are the defaults values used for when creating A/B tests:

- **Test Duration:** 30
- **Participation Percentage:** 10
- **Automatically publish the winner of the test if the results are significant:** False
- **Confidence Level:** 95%

#### Setting | Description
--- | ---
**Test Duration** | Sets the default test duration in days. This can be changed in edit view when setting up an A/B test.
**Participation Percentage** | Sets the default number of A/B test participants in percentage. This can be changed in edit view when setting up an A/B test.

If the participation percentage is set to 20, 20% of the site visitors participate in the A/B test. Half of the test participants are directed to the original version, and half to the variation version; the A/B test then measures which version has the...
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically publish the winner of the test if the results are significant?</td>
<td>Set this to <strong>True</strong> and an A/B winner is automatically published when the A/B test completes and the results are statistically significant according to the set confidence level. The winner is the version that has the higher conversion rate. If the conversion rates are equal, the editor must pick a winner manually. This setting affects all A/B tests on the site. The default setting is <strong>False</strong>.</td>
</tr>
<tr>
<td>Confidence Level</td>
<td>Sets the default confidence level of statistical significance you want from the A/B test results. This can be changed in edit view when setting up an A/B test. The confidence level determines how likely it is that a winning page is in fact better. That is, that the difference between the winning page and the challenger are not due to coincidence. For example, a 95% confidence level means that 95 identical test cases out of 100 would end with the same result. In other words, the higher the number, the more reliable test result.</td>
</tr>
</tbody>
</table>

## Search configuration

You can configure different **search providers** depending on the type of content on your website. A search provider searches across the website for pages, blocks, files, categories, forums or page types, or products on an e-commerce website. Search results are available when searching in the global Episerver menu in edit view.

### Enabling search providers

You can decide which search providers you want to enable, and the order in which they appear in the search hit list. To access these settings, go to the admin view and select **Config > Search Configuration**.

- **Blocks.** Allows for search in blocks.
- **Files.** Allows for search in files.
- **Pages.** Allows for search in pages.
- **Jump to.** Makes it possible to jump directly from the search hit list to **menu alternatives** matching your search criteria.
- **Products.** Allows for search in products if you have Episerver Commerce installed.
- **Find files, blocks and pages** if you have Episerver Find installed.

You can drag and drop the search provider options to change the order between them. This controls the order in which the results are displayed in the hit list. Clearing a check box disables this search provider option.
Properties

Properties are central in Episerver CMS. Content type properties store and present data, such as page types and block types, and they are fields where editors enter information into a page type. A property can be the page name, an image placeholder, or the editor area, where you can add text. For example, the XHTML editor is a property of the type XHTML String (>255), which results in an editorial area in the page type when used. For property content to be visible to visitors, link it to a content type with corresponding rendering.

Property types

You can define properties in code or from the administrative interface. For certain properties defined in code, you can create “non-breaking” changes in admin view to override these settings. If a property is defined in code and cannot be changed in admin view, information appears. If you make changes to a property defined in code, you can reset the changes to the values defined in code.

The following types of properties are used:

- **Built-in properties** are set by the system and are automatically available for all pages and blocks regardless of type. For example, PageName (name of the web page) and PageStartPublish (start publish date for the page).
- **User-defined properties** are added to the page or block type definition in code or from the admin view. Typical examples are Heading and MainBody.

You can locate property settings under the **Config** tab in the Property Configuration section, and under the **Content Type** tab when you work with content types.

Editing and adding properties on content types

A common example for editing properties is to define toolbar buttons for the TinyMCE rich-text editor. You normally define properties in code but occasionally add them in admin view, because properties added from there are not rendered.

When you edit and add properties, the following tabs are available:

- **Common Settings** is where you edit a property's common settings.
- **Custom Settings** depend on the property data type being editing.

Editing a property

The upper **General** section of the Common Settings tab contains information about a selected property. If a property is defined in code, information about it is displayed, but you cannot change...
values such as property type and presentation control. You can change other settings, such as making a property mandatory or searchable. The lower User Interface part contains settings related to the property display in edit view.

See Adding a Property below for information about available settings for properties.

Adding a property

1. In admin view, from the Content Type tab, select a page type and click Add Property.
2. Fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Select a property type. You can choose from several property types: integer, string, page, date, and so on. You also can create a property type.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Name the property. This is used when programming and making language settings.</td>
</tr>
<tr>
<td><strong>Presentation control</strong></td>
<td>Use of multiple editors is supported but the TinyMCE editor is used most often, and the Presentation control drop-down list appears dimmed. If your website is configured to allow multiple editors and you chose the property type XHTML String (&gt;255), the Presentation control drop-down list is enabled, and you can select the XHTML editor to use.</td>
</tr>
<tr>
<td><strong>Default value</strong></td>
<td>Select a value for the property. This is the default value on all pages where it is used. You can specify a default value for both customized and built-in properties.</td>
</tr>
<tr>
<td><strong>Value must be entered</strong></td>
<td>Select the check box to make it mandatory to enter a value for the property before saving. The setting is configured per property and content type.</td>
</tr>
<tr>
<td><strong>Searchable property</strong></td>
<td>Clear the check box to exclude a property from search. It might be beneficial to avoid undesired property values the search index. By default, all properties are searchable.</td>
</tr>
<tr>
<td><strong>Unique value per language</strong></td>
<td>Select whether the property is unique for a certain language. This is needed only if the website supports globalization.</td>
</tr>
<tr>
<td><strong>Display in edit view</strong></td>
<td>Determine if the property is visible in edit view. By default, all properties are visible in the editorial interface. The setting is configured per property and page type.</td>
</tr>
<tr>
<td><strong>Field name</strong></td>
<td>Specify a heading for the property. This text is displayed for the editor when editing the page in All Properties editing view unless a translation of it has been added language resources.</td>
</tr>
<tr>
<td><strong>Help text</strong></td>
<td>Specify a help text. This text should help the editor understand how to use this property, and is displayed in All Properties editing view when hovering over the property name.</td>
</tr>
<tr>
<td><strong>Tab</strong></td>
<td>Select the tab on which the property is to be displayed in the Tab drop-down list.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Sort index | Select a relative number to sort this property among other properties.

3. Click **Save**.

The **Custom Settings** tab displays custom information for the selected property type. Here, you define available buttons in the toolbar of the TinyMCE rich-text editor, which is based on the property type **XHTML string (>255)**.

### Defining language-specific properties

When working with globalization, you define in every template which fields vary depending upon the language. To do this, set whether the property for that field should be "locked" or "open" for globalization. This is done using the **Unique value per language** setting in admin view.

Properties that have unique value per language are editable in all enabled languages on the website, which is normally the case. You can edit only properties that do not have language-specific values in the language in which the page was created (the original page language). These properties are disables in edit view with an icon indicating the original language.

Imagine the property defining the sort order field is not set as a unique value per language (that is, the **Unique value per language** check box is cleared). When creating a new page, you can set sort order in the original page language. But if you create a version of the page in another language, the sort order field is not editable. As a result, the sort order is the same for all enabled languages. If you want to change the sort order for each language, select the **Unique value per language** check box.

![Warning]

If a property is changed to not having a unique value, all existing values for that property are deleted. So if the property for the editor area is changed to not have a unique language, all text entered in the editor area for all languages on the website are permanently deleted.

### Setting a property to be language-specific

1. On the **Content Type** tab, select the page type that contains the property to be set.
2. Click the name of the property that you want to change.
3. Select the **Unique value per language** option.
4. Save your changes.

**Organizing properties in content**

You can alter the order in which properties are displayed to editors in a page or block type. You can also move properties between tabs in a page type. These changes are done for each page type in admin view.

**Changing the order of properties**

Follow these steps to change the order in which properties appear in the All Properties editing view. For example, you can display important properties at the top of the page.
1. Select the page or block type on the Page Type or Block Type tab.

![Image of page type selection]

2. Click an arrow to move a property, or drag and drop the property to a desired order.

Placing a property on a tab

1. Select the page type on the Content Type tab.
2. Click the name of the property that you wish to modify.
3. In the Tab drop-down list, select the tab on which the relevant property will be placed.
4. Click Save.

Configuring customized property settings

On the Config tab under Property Configuration > Edit Custom Property Types, you can configure custom property types.

Priorities and configuration
The property settings have the following priority:

1. A specific setting for a property defined in admin view. This can be either a custom settings for this property or pointing to a specific global setting.
2. A specific setting for a property defined for the model in code.
3. A global setting defined in admin marked as the “Default” settings for the property type.
4. A global setting defined in code.

You can create a property, name it, and give it a data type and other settings.

**Creating custom property types**

The list of available custom property types done by a developer has the following columns:

- **Name**: The name of the content type created by a developer, of which some are selectable in the editorial interface.
- **Base type**: Shows the built-in types that can be extended by a developer.
- **Class name**: Shows the full name of the class. The class is defined in the assembly.
- **Assembly name**: Shows the class reference. A blank column indicates a built-in property.

A developer can create property data types by inheriting from the existing available ones.

<table>
<thead>
<tr>
<th>Data type name</th>
<th>Base type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Selected/not selected</td>
<td>True or false.</td>
</tr>
<tr>
<td>Number</td>
<td>Integer</td>
<td>An integer.</td>
</tr>
<tr>
<td>FloatNumber</td>
<td>Floating point number</td>
<td>Number with decimals, for example, 3.14.</td>
</tr>
<tr>
<td>PageType</td>
<td>Page Type</td>
<td>Episerver CMS page type defined in admin view.</td>
</tr>
<tr>
<td>PageReference</td>
<td>Page</td>
<td>Link to an Episerver page in the current site.</td>
</tr>
<tr>
<td>Date</td>
<td>Date/Time</td>
<td>Date and time.</td>
</tr>
<tr>
<td>String</td>
<td>String (&lt;=255)</td>
<td>Short text, fewer than 256 characters in length.</td>
</tr>
<tr>
<td>LongString</td>
<td>Long String (&gt;255)</td>
<td>Used for text that can exceed 255 characters in length, for example the main editor area in edit view.</td>
</tr>
<tr>
<td>Category</td>
<td>Category selection</td>
<td>List of categories.</td>
</tr>
<tr>
<td>Data type name</td>
<td>Base type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>LinkCollection</td>
<td>Link collection</td>
<td>A collection of links that can be added and edited in edit view.</td>
</tr>
</tbody>
</table>

Default values for properties are not defined in code.

**CMS Configuring the rich-text editor**

The editor in Episerver CMS is configured on the Page Type tab, by selecting a page type and either adding or updating a property of the XHTML String (>255) type.

Properties based on the XHTML String (>255) property type result in a rich-text HTML editor, which you can configure by choosing which buttons are available. In a standard installation of Episerver CMS, the editor is a customized version of the open source rich-text editor TinyMCE. TinyMCE has many functions, is easy for developers to customize, and works with all browsers supported by Episerver CMS.

This description applies to a standard installation of Episerver CMS, with a selection of functions being available. You can incorporate additional functions and customizations into the editor from admin view. See Episerver World and the official TinyMCE website for information.

You can adapt the rich-text editor to suit different groups of editors through the availability of different buttons. You also can change the size of the rich-text editor dialog. To change these settings, first configure the property to use property XHTML String (>255) type. This enables the fields in the Custom Settings tab.

You use two kinds of settings to change the editor's layout and buttons: global settings and custom settings. You configure the layout of the editor toolbar the same way regardless of the type of setting.

You can watch the following demonstration video, Modifying the TinyMCE editor options. (6:39 minutes)

**Changing the layout of the editor**

1. Enter the required width and height of the editor (in pixels) in the Height and Width fields.
2. If needed, change the path to the cascading style sheet (CSS) that is used in the editor with the Content CSS Path field.
3. Drag and drop icons that you want available from the editor toolbar designer to and from the Inactive tools section.
4. Remove an icon by dragging it from the toolbar designer and dropping it in the Inactive tools section. The icon is automatically placed in the category to which it belongs.

5. Add an icon to the editor by dragging it from the Inactive tools section to the desired position in the toolbar designer.

6. Add and remove rows from the editor by clicking Add Row and Remove Last Row. The easiest way to clear all the icons from the toolbar designer and start from scratch is by clicking Clear Rows.

7. Configure the editor plug-ins and click Save.

In the lower part of the Create New/Edit Property dialog, you can choose whether to use an advanced image or link dialog box. You also can turn on the word count in the editor, and specify if you want to use the Episerver CMS file selection dialog box. By default, the advanced image dialog box is used with the Episerver CMS file selection dialog box.
Enabling plug-ins

Some editor plug-ins are enabled always in a standard installation of Episerver CMS. These are configured in the Plug-in Manager on the **Config** tab in admin view.

- **Change list buttons to advanced list buttons** enables a drop-down list with advanced types for nested lists, such as square, lower alpha, and lower roman.
- **Change image dialog to Advanced image dialog** enables an advanced Add/Edit Image dialog box. Select this check box to configure advanced properties for your images.
- **Word count** enables word count functionality. Select this option to add a **Words** field to the bottom right of the editor. This displays the number of words included in the editor area.

Configuring global and custom settings

Global settings let you change the layout and the buttons in the rich-text editor toolbar for a property. You can use global settings on all page types as a default, or on only one page type. You can have as many global settings as you like on your website to create an editor suitable for all editors working with the website. You also can apply custom changes for a specific page type.
Configuring global settings for the XHTML String (>255) property

When you apply a global setting to all properties based on the XHTML String (>255) property type, all the editors on the website using a global setting are based on this, unless otherwise stated that a editor should be based on another global setting or a custom setting.

1. On the Page Type tab, select Edit Custom Property Types and click Add Setting.
2. Enter a descriptive name for the global setting.
3. Change the layout of the rich-text editor, configure the plug-ins, and click Save. The global setting appears in a list.

![Click Set as Default for one setting to use it for all the editor toolbars on the website, unless another setting is chosen for the property in a certain page type. If you do not configure a global setting as default, the properties use the standard toolbar set at installation.]

Configuring global settings for a property on a page type

You can configure a global setting for a specific property on a specific page type.

1. Open the page type for which you want to change the global settings on the Page Type tab in admin view.
2. Click the property you want to configure and select the Custom Settings tab.
3. Select the Use global settings check box and select Use default settings if you want to use the default settings for the property.
4. Create a new global setting for the property by clicking Manage global settings.
5. Add a global setting by following the instructions on how to Configuring global settings for the XHTML String (>255) property.
6. Change the layout of the rich-text editor, configure the plug-ins, and click Save.
7. Change the global setting in the drop-down list and click Save.

Configuring custom settings

Use custom settings to change the layout and the buttons in the rich-text editor toolbar for this property on this page type only.

Configure a custom setting as follows:

1. On the Custom Settings tab, select the Use custom settings radio button.
2. Change the layout of the rich-text editor, configure the plug-ins and click Save.

Deleting a global setting

To delete a global setting, open the setting and click Delete.
Content types

Content in Episerver can be page and block types, folders, or media files such as images and documents. Content can also be products in a product catalog in Episerver Commerce.

Content types and properties

Page and block types contain the properties where editors enter information, such as a link to an image on a web page.

For a content type, you define a set of properties that can hold information, such as a link to an image, a web page, or editorial text. A typical website has a set of content types that match the identified functions needed on that website.
The content type is the foundation from which you create one or many page or block instances. To display content to visitors, the page or block type and its properties need to be mapped to corresponding rendering.

The content concept in Episerver is based on inheritance from a “generic” content type, which then is used to create specific content types, such as a page type or a media folder. Using this feature, developers can create custom content types easily when they set up new websites.

- You can define page types either in code or from the admin view. However, you can define block types only in code.
- For page types defined in code and for all block types, you can define “non-breaking changes” of properties in admin view.
- You are notified if you cannot change the settings defined in code in admin view.
- If you make changes to a page type defined in code, you can reset the changes to the original values defined in code.

Page types

Be careful when you alter page type settings because changes may cause the website to stop working. Although you can create page types in admin view, you should create them from code.

Editing a page type
To edit settings for an existing page type, open the page type on the **Page Type** tab, click **Settings**, change the settings, and click **Save**.

Because you can identify page types and their properties either in code or from the admin view, you can change some settings from admin view. If a page type is created from code, this is shown on the page type information page under **General**.
You cannot delete certain page types defined in code. These are typically page types upon which other page types are based, such as the standard or default page and the start page.

Using the Access level area, you can define which users or user groups will have access to the page type.

You can watch the following demonstration video, Making a page type available for some users but not for others. (3:06 minutes)

Creating a page type from admin view

1. On the Page Type tab, select Create New Page Type.
2. Set values in the Information tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the page type here.</td>
</tr>
<tr>
<td>Display name</td>
<td>Enter the name that will be displayed in the list of available page types.</td>
</tr>
<tr>
<td>Description</td>
<td>The text describing the page type, will be displayed in the list of available page types.</td>
</tr>
<tr>
<td>Sort index</td>
<td>Determines the sorting (ascending sort order) in the list of available page types in edit view; default is 100.</td>
</tr>
<tr>
<td>Available in edit view</td>
<td>This option makes the page type available for selection when creating new pages in the editorial interface. You should hide page types that are rarely used by editors, for instance the start page type. You can make these available when needed, and then hide them again.</td>
</tr>
<tr>
<td>Display Template</td>
<td>Select one of the following templates to be used for the page type:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Web Form template path.</strong> Enter a path to the aspx page template file that displays the content of the page.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Web form template.</strong> Select a Web Forms template that the page type is associated with. If your developer created several templates using type classes, these appear in the list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>MVC template.</strong> Select a MVC template with which the page type is</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Registered template</td>
<td>Select to use registered page templates for displaying content. The registered page templates are available for selection in the drop-down list. You then can associate a page type with predefined page templates to display the same content using different channels.</td>
</tr>
<tr>
<td>Advanced information</td>
<td>Displays information about the GUID, class name and assembly name for the page type.</td>
</tr>
</tbody>
</table>
| Access level              | Determines the users and user groups for which the page type is available when creating new pages. The default setting is Everyone (available to all users and groups). See chapter Access rights for more information. Do the following to limit access rights for a page type:  
  1. Clear the Create check box to remove Everyone from the access level setting.  
  2. Click Add users/Groups and select the relevant users or groups.  
  3. Make sure that the Create check box is selected for the desired users and groups. |


You can set default values for some of the built-in properties in Episerver CMS from admin view. You also can specify default values for the properties from code, but these are not visible in the admin view.
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Publish Date</strong></td>
<td>Select the <strong>Use adjusted default settings...</strong> and the value in time when the system should publish the page after it has been created. Mostly used for news pages that are available on the website for a short time.</td>
</tr>
<tr>
<td><strong>Stop Publish Date</strong></td>
<td>Select the <strong>Use adjusted default settings...</strong> and the value in time when the system should stop the page from being published. Mostly used for news pages that are available on the website for a short time.</td>
</tr>
<tr>
<td><strong>Display in navigation</strong></td>
<td>Select this option if the page type, for example, a news item page that should never be displayed in menus for navigation. This is done by clearing the <strong>Display in navigation</strong> property, which is then the default value for this page type.</td>
</tr>
<tr>
<td><strong>Sort index</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Sort subpages</strong></td>
<td>Select how you want the pages to be sorted, according to creation date or other.</td>
</tr>
<tr>
<td><strong>Archive to</strong></td>
<td>Browse the path to where you want the pages archived. Then, you can run a scheduled job to clean up archived pages as described in <strong>Scheduled jobs</strong>.</td>
</tr>
<tr>
<td><strong>Target frame</strong></td>
<td>Select if the page should be opened in a new window or in the same window.</td>
</tr>
</tbody>
</table>
4. Set values on the **Available Page Types** tab.

When creating new pages, you should limit the available page types in the page type list, to make it easier for editors to choose the correct page type. For example, for a *News List* parent page, you can specify that the only available page type is *News Item*.

![Edit "Standard Page"

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use Default Settings</strong></td>
<td>Select to revert to default settings as defined in code for this page type.</td>
</tr>
<tr>
<td><strong>All</strong></td>
<td>You can create pages based on all page types available in edit view.</td>
</tr>
<tr>
<td><strong>None</strong></td>
<td>You cannot create child pages for this page type.</td>
</tr>
<tr>
<td><strong>Selected</strong></td>
<td>Manually select the page types that should be available.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Copying an existing page type**

When you copy a page type, its properties also are copied. You can then edit the information for the page type and its properties. Copy a page type as follows:
1. Select **Copy Page Type** in the **Page Type** tab in admin view.
2. Select the page type that you want to copy from the drop-down list and click **Copy**. A window appears containing the exact same properties.
3. Edit the page type information to suit your requirements and click **Save**.

**Block types**

Block types are similar to page types, and you can modify some settings from admin view.

![Image of [AlloyTech] Text block]

Edit the settings for an existing block type as follows:

1. Select the block type on the **Block Type** tab and click **Settings**.
2. Change one or several of the settings as described for Creating a page type from admin view.
3. Click **Save**, (or **Revert to Default** if you want to restore your settings).

**Other content types**

By default, there are generic content types for other types of content such as folders and media files. Based on these, developers can create specific content types. You can have a specific folder or media file content type, where you can add properties such as **Copyright** or **Photographer**.

**CMS** Converting pages

You can convert pages from one page type to another. This is useful if you want to move information from an old to a new page type or created a page based on the wrong page type.

Each page type contains properties. When you convert a page, you map the properties of the old page type to corresponding properties of the new one.
All page versions are converted. Therefore, ensure that no users are working with the page types to be converted.
A page property in the new page type can be mapped only to one old page property.

1. Select **Convert Pages** from the **Content Types** tab in admin view.

2. Select a page in the **Select pages to convert** field.
3. Select the **Convert the selected page and all subpages (of the selected page type)** check box if you want all the subpages to be included in the conversion.
4. Select the page type that you want to convert from in the **Convert from Page Type** list. The list of page properties included in that page type updates in the **Convert from Property** list.
5. Select the page type that you want to convert to in the Convert to Page Type list. The list of page properties included in that page type updates in the Convert to Property list.

6. Map each page property to a corresponding property in the page type to which you want to convert.

7. Click **Convert**.

8. To test the conversion, click **Test Conversion and Show Log**, which displays a detailed log of converted pages and page properties.

> Selecting **Remove property permanently** deletes the property, which may damage existing content that uses the property.
Personalization in Episerver lets you target website content to selected visitor groups. The personalization feature is based on customized visitor groups that you create based on a set of **personalization criteria**. Episerver provides a set of basic criteria such as geographic location, number of visits, and referring search phrase. You can also develop customized criteria.

### Built-in visitor group criteria

The Episerver platform comes with the following built-in visitor group criteria.

<table>
<thead>
<tr>
<th>Visitor group criteria</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Site Criteria**      | **Number of Visits.** Matches the number of times the visitor has visited the website. You can specify Less than, Equal, or More than, within a number of days (weeks, months or years), or since a date, or in total. For example, *Less than 1 [visit] within 10 days.*  
**User Profile.** Matches a value stored in a user’s profile. You can specify Last Name, First name, Company, Address, Title, or email address. Each item can be equal to, contained in, start with or end with the specified value. For example, *Company Equals ExampleCo.* See example.  
**Visited Category.** Select one of the website’s page categories. You can also select a number of pages which use that category that have been visited. The visitor must have visited the specified number of pages to which the category is applied. For example, *Category X viewed at least 3 pages out of a total of 6.*  
**Visited Page.** Select one site page. The visitor must have visited that page during the current session. |
| **Time and Place Criteria** | **Geographic Coordinate.** Uses the visitor’s approximate location in a geolocation database (based on visitor IP address). Drag the marker to the map (Google maps), and select a radius around that point to indicate the visitor’s proximity to the location. See example.  
**Geographic Location.** Matches the visitor to a specific continent, country, and region. For example, *Continent: Europe, Country: Norway, Region: Oslo.* You also can specify a wild card for country and region. For example, *Country N* in Europe yields Netherlands and Norway. See example. |
<table>
<thead>
<tr>
<th>Visitor group criteria</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time of Day.</strong></td>
<td>Matches the visitor's time period with the start time, end time (15-minute intervals), and days you specify. For example, <em>From 2:00 PM to 4:15 PM on Monday, Tuesday, and Friday.</em></td>
</tr>
<tr>
<td><strong>URL Criteria</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Landing URL.</strong></td>
<td>Matches the URL with which the visitor enters the site. You can decide if the landing URL is equal, starts with, or ends with the with a specified value. For example, <em>contains <a href="http://www.example">www.example</a> to match <a href="http://www.example.com">www.example.com</a>, <a href="http://www.exampleURL.com">www.exampleURL.com</a></em> and so on.</td>
</tr>
<tr>
<td><strong>Referrer.</strong></td>
<td>Matches the Host name or URL of the referred page that was clicked before entering the site, such as a search engine result page. You can decide if the referrer criteria should match on equal, contain, start with, or end with a specified value for the whole or parts of the Host name or URL. See example.</td>
</tr>
<tr>
<td><strong>Search Keyword.</strong></td>
<td>Stores the URL of the referred page that was clicked before entering the site, such as the URL of a search engine result page. Your partner developer can define this criteria to specify the search word to match against the URL by a regular expression. The regular expression finds search words in the URL. Note: This criterion is not compatible with Google due to privacy restrictions for Google searches.</td>
</tr>
<tr>
<td><strong>Visitor Groups.</strong></td>
<td><strong>Visitor Group Membership.</strong> Select members from existing visitor groups. For example, <em>Member of Job Applicants, or Not a Member of Start Customer Club.</em></td>
</tr>
<tr>
<td><strong>Episerver Forms</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Submitted Form.</strong></td>
<td>Matches when a visitor submits (or does not submit) a particular form that you select from a drop-down menu. For example, <em>Has Submitted Job Application.</em> See example.</td>
</tr>
<tr>
<td><strong>Submitted Form Value.</strong></td>
<td>Matches when a visitor submit a particular form value. See example.</td>
</tr>
</tbody>
</table>

**Managing visitor groups**

Visitor groups are managed from the Visitor Group option in the global menu. When creating a new visitor group, you select one or more criteria and define appropriate settings. Those criteria are used to determine whether a user visiting the website is a part of that visitor group.
You can make the editor a member of VisitorGroupAdmins. This group provides access only to the Visitor Groups option in the global menu.

Creating a visitor group

1. From the global menu, select CMS > Visitor Groups.
2. Click Create.

3. In the Criteria section, click to add criteria for the visitor group as follows:
   a. In the Match drop-down list, select the criteria to match All, Any or Point. What you select here affects all criteria for the visitor group. Using points is a way to set a value for what a desired action on the website is worth.
   b. Drag the criteria from the pane on the right and drop it into the Drop new criterion here area.

4. Make the settings for the criteria, see examples described in Examples of creating visitor groups.

5. In Name, name the visitor group you are creating. This name is displayed in the personalized content box when you select the content on a page.

6. In Notes, type a descriptive text about the visitor group you have created, for example, its purpose. This description is displayed as a tooltip when the editor is adding a visitor group to the content on a page.
7. In **Security Role**, select the check box if you want this visitor group to be available when setting access rights for pages and files in admin view. Note that visitor groups only have read access.

8. In **Statistics**, keep the check box selected to enable statistics for the visitor group (this check box is selected by default).

9. Click **Save**.

**Editing a visitor group**

1. From the global menu, select **CMS > Visitor Groups**.

2. Click **Edit** for the visitor group you want to change.

3. Add a new criterion for the visitor group by drag-and-drop, change the value for an existing criterion, or click ✗ to delete an existing criterion.

4. Click **Save**.

   ![Visitor Groups](image)

   If you change the name of a visitor group available in the list for access rights, the settings for this visitor group no longer work.

**Copying a visitor group**

1. From the global menu, select **CMS > Visitor Groups**.

2. Click **Copy** for the visitor group you want to copy. The new copy has the same name as the original but with the extension "- Copy".

3. Rename and change criteria for the new visitor group you have copied.

**Deleting a visitor group**

1. From the global menu, select **CMS > Visitor Groups**.

2. Click **Delete** for the visitor group you want to delete.

3. Confirm the deletion.

**Viewing and clearing statistics**
The visitor group statistics appear as a gadget on the dashboard. Clear the statistics from the database as follows:

1. From the , select **CMS > Visitor Groups**.
2. Click **Clear statistics**.
3. Confirm the deletion.

⚠️ The **Clear statistics** button permanently deletes statistics from the database. This action cannot be undone.

### Examples of creating visitor groups

**EXAMPLE: Site criteria and points**

By using **Points**, you can set a value for how much an action is worth, for example, a visited campaign page. In this example, a visitor who visits the page on a certain date matches the visitor group criteria.
1. In the **Match** drop-down list, select the criteria to match **Point**.
2. Drag and drop the **Visited Page** criterion, and select page. Use drag-and-drop of the criteria again to add several pages.
3. Drag and drop the **Number of Visits** criterion, and select **More than > 1 > Since [date]**. (To create a visitor group for visitors who have never visited the page, select **Less than > 1 > Since [date]**.)

4. Enter the number of points each criterion is worth, and select whether or not the criterion is required.
5. Select **Threshold** for the criteria you added in your visitor group. For example, the visitor must fulfill 1 of 3 criteria to be included in the visitor group.
6. Click **Save**.

**EXAMPLE: Geographic location**

You can direct content to visitors from a specific country and specific days. For example, people from Sweden visiting your website on weekdays. You can show these visitors a clickable banner to sign up for a conference.

1. Drag and drop the **Geographic Location** criteria, and select **Continent**, **Country** and/or **Region**. Use drag-and-drop of the criteria again to add several countries.

2. Drag and drop the **Time of Day** criteria, and select **[weekday]**. You can also select the personalization to start and end at a specific time.
3. Click **Save**.

**EXAMPLE: Geographic coordinate**

You can direct your content to visitors from a specific part of a city, for example, "People from Upplandsgatan, Stockholm".

1. Drag and drop the **Geographic Coordinate** criteria, and click **Select Location**.
2. Click **Select location** to display a map that you click to set a location. You can zoom in the map for more precise locations.
3. Select the **Radius [number of kilometers or miles]**.

4. Click **Save**.

**EXAMPLE: Referrer**

The HTTP Referrer is based on pages, such as those used in a campaign. For example, you can target content to visitors who

1. Drag and drop the **Referrer** criteria, and select **URL > Equals** > the URL of the search engine result page, for example, http://www.google.se/#hl=sv&source=hp&biw=1338&bih=790&q=episerver+cms.

2. You also can add the **Geographic Location** to select a country.

3. Click **Save**.

**EXAMPLE: Form and form values**

You can base a visitor group on whether the visitor has (or has not) submitted a particular form or form value. For example, you can target content to visitors who submit a Job Application form:

You can target content to visitors that give you a low rating on a Satisfaction Survey.

**Additional visitor group criteria**

You can extend the built-in visitor group criteria as follows:
Episerver Commerce criteria

Visitor group criteria specific for e-commerce, such as customer properties, markets, and order frequency criteria. See Personalization for Commerce.

Episerver Visitor Group Criteria Pack

- Display Channel matches the visitor’s current display channel when visiting the website, such as distinguishing between web and mobile visitors.
- IP Range matches the IP range either equal to, below, or above a defined IP number the visitor used when visiting the website.
- OS & Browser matches the operating system and browser the visitor used when visiting the website.
- Role matches the access roles the visitor had when visiting the website. You can either include roles by using the `in role` condition, or exclude roles by `Not in role`.
Index

A
A/B Testing
configuration ........... 83
access rights
add-ons .................. 34
administer ............... 19
change .................... 19
create ..................... 19
delete ..................... 19
languages ................. 33
overview .................. 19
publish .................... 19
read ....................... 19
setting
from permissions for
functions ............... 75
visitor groups ........... 32
add-ons
access rights ............. 34
administration view ....... 16
administrators
role ....................... 14
approval sequences
managing ................. 63
archive function, job ....... 42
assets
remove unrelated
content ........... 44
configuration
A/B Testing ........... 83
content
editor role .............. 14
publishing
delayed job 43
types ................. 97
versions
deleting
disabling 51
maximum number 51
BLOBs
abandoned, remove
job .................... 44
block types ............... 104
blocks
maximum number .. 51
C
categories
adding .................. 71
deleting .................. 72
editing .................. 72
overview .................. 71
change log .................. 76
auto ..................... 76
auto truncate job ....... 42
disabling .................. 76
enabling .................. 76
filtering .................. 77
channels
creating .................. 80
community member role 13
CSS file
rich-text editor
path to 51
D
deleting
approval sequence .... 63
developer role ............ 14
E
editing
approval sequence .... 63
tab, system settings 51
encrypt, con-
nec-
tionstrings.config
file ................. 50
error handler, system settings ........ 50
exporting CMS data .............. 46
frames, overview ............ 73
general tab, system settings .......... 50
global menu ............. 12
globalization enabling ............ 50
jobs, scheduled, CMS ........ 41
languages access rights .......... 33
adding .................. 58
deleting .................. 62
editing .................. 58
enabling .................. 58
overview .................. 58
licenses available per website ........ 54
login ........................ 12
Manage Content tool .......... 45
marketer role ............. 14
media, auto publish on upload ........ 52
menu, global ................ 12
merchandiser role ....... 14
mirroring creating a channel .... 80
overview ................ 79
service job ............ 43
multi-site ............. 53
notifications dispatcher, scheduled job ...... 43
truncate message, scheduled job .... 43
page types converting ............ 104
overview ........................ 98
pages converting to another type ............ 104
maximum number ............ 51
permissions see access rights ... 19
personalization overview .................... 107
plug-in manager ............ 76
plug-ins, rich-text editor, enabling ............ 95
properties adding .................. 87
built-in .................... 86
custom settings ........ 89
custom types, creating ............ 92
custom, configuring ........ 91
editing .................... 86
language specific ........ 89
organizing .................... 90
overview .................... 86
types .................... 86
user-defined .................... 86
rebuild name for web addresses ............ 78
rich-text editor configuring .................... 93
custom settings ........ 96
global settings ........ 95
global settings, deleting ............ 96
layout, changing ........ 93
path to CSS file ........ 51
plug-ins, enabling ........ 95
roles ........................ 13
administrator ........ 14
community member ........ 13
content editor ........ 14
developer ........ 14
marketer ........ 14
merchandiser ........ 14

© Episerver 2017
visitor ........................ 13
website owner ............ 14

S
scheduled jobs
A/B test .................... 43
archive function ......... 42
change log auto truncate ........ 42
clear thumbnail properties ........ 42
link validation .......... 42
marketing test monitor .......... 42
mirroring service ........ 43
monitored tasks auto truncate ........ 43
notification dispatcher ........ 43
notification message truncate ........ 43
overview ............. 41
publish delayed content ........ 43
remove abandoned BLOBs ........ 44
remove permanent editing ........ 44
remove unrelated content assets ........ 44
running manually .... 41
setting up automatic intervals ........ 41
subscriptions ........ 44
trash, empty ........ 42
search configuration .... 84
subscriptions
job .................... 44
updates handler, system settings .......... 50
system settings ........ 50
auto publish media on upload ........ 52
disable deletion of content versions ........ 51
editing tab ........ 51
enable globalization ........ 50
encrypt configurationstrings.config file ........ 50
derror handler ........ 50
general tab ........ 50
globalization enable ........ 50
handler for subscription updates ........ 50
maximum number of stored versions ........ 51
path to CSS file for rich-text editor ........ 51
unlimited versions ........ 51

T
tabs
overview ............. 73
thumbnail properties,
clear, job ........ 42
tool settings ........ 76
trash
emptying on a schedule ........ 42

U
user groups
creating in CMS ......... 39
deleting in CMS ......... 39
displaying members ........ 36
overview ............. 34
users
creating ........ 35
deleting ........ 35
editing ........ 35
overview ............. 34

V
video
Making a page type available for some users .... 100
Managing access rights ........ 19
Modifying the TinyMCE editor options ........ 93
visitor groups
   access rights  ......... 32
   copying ................. 110
   creating ............... 109
   criteria, built-in ...... 107
   deleting .................. 110
   editing .................. 110
   examples ............... 111
   overview ............... 107
statistics
   clearing 110
visitor role ............... 13

W
web address, rebuild
   name .................. 78
websites
   adding .................. 54
   available licenses ... 54
   domain mapping ....... 54
   managing ............... 53
   multi-site setup ...... 53
   owner role ............ 14
   requirements .......... 53
   single-site setup .... 53
   unique URL ............ 54